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This Manual contains instructions for two products: Serialtest Async and Serialtest Spy.  The two products
are very similar but the initial setup varies.  Serialtest Async works in conjunction with a custom cable set
included with the product, while Serialtest Spy does not require cables.  There is also a combination
package that includes both Serialtest Async and Spy.  Check your diskette labels or registration form to
determine which product you have.

The license for the combination package allows you to run either Serialtest Async or Serialtest Spy on one
machine only.  If you need to run both products concurrently on the same PC or on two different PCs,
please contact Frontline to purchase an additional license.

Packing List

Serialtest Async and Serialtest Async+Spy
•  Cable Set, containing one Routing Cable, one Monitor Head, one Source Head and two 25-9 pin

adapters
•  This Setup and Quick Start Guide
•  License Envelope with Product Registration Card and software

Serialtest Spy
•  This Setup and Quick Start Guide
•  License Envelope with Product Registration Card and software

System Requirements

•  PC with Windows 95 OSR2 (version 950b), Windows 98 or Windows NT and a Pentium processor or
higher

•  16 MB of RAM (32 recommended for NT)
•  5 MB free Hard Disk Space (capture file size is limited by disk size)
•  Minimum of one COM port, two required for bi-directional monitoring when using cable set
•  Serialtest supports COM1 through COM64
•  Maximum data rate supported is dependent on PC processor speed
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Quick Start Guide and Hardware Configuration

Introduction to Frontline Test System

Welcome to the Frontline Test System!  Frontline Test System (FTS) is a family of products designed to
let you conduct data analysis using your personal computer, of which Serialtest is the serial data analysis
component.  The FTS interface is easy to use without training, but you will want to read the online help
to learn how to take maximum advantage of all the features.

We have tried to make the help complete and easy to use.  The Table of Contents will guide you towards
general information on different areas of the product, and the Index will help you find specific
information on a particular topic.

This entire manual is also available in the online Help.  To access Help, choose Help from the Help
menu on the Control window, or press F1 on any window.

If you need assistance setting up the cables, please refer to the Cable Configuration section of the
manual.

For assistance on choosing which COM ports to use with FTS, please refer to the Hardware Settings
section.

If you want to get up and running quickly and have no need to do anything more complicated than
capture data, please read the Quick Start Guide, which contains an overview of data capture and review.
If you are a Serialtest DOS user, the Quick Start will help you quickly become familiar with the
Windows product.

Installing the Software
If you are installing the product for the first time, follow these steps:

•  Insert the media into the drive.
•  Run SETUP.EXE.  You can do this from the command line, Windows Explorer, or the Add/Remove

Programs icon in the Control Panel.
•  Follow the instructions on your screen.  You will need your serial number (found on your registration

card) to complete the installation.
•  Fill out your registration card and send it in!  This will help us to keep you informed on product

upgrades.  You can register online at our web site, www.fte.com.

If you are installing an add-on product or additional copies of FTS, follow these steps:

•  Double-click on the Frontline Test System folder on your desktop, and double-click on the FTS Setup
icon, OR

•  Click on the Start button, and choose Programs —> Frontline Test System —> FTS Setup.
•  Click on the Setup Tab and then click on the Install button.
•  Enter your serial number.  Click OK.

Starting Serialtest
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When Serialtest is installed, it creates a folder called Frontline Test System on the desktop.  This folder
contains icons used to start Serialtest, including icons for the help files, FTS View (see the online Help for
more information on View mode), FTS Setup, and for the demos of each product.  There will also be an
icon for each product installed.  By default, these icons are called:

Product Name                                    Icon Name
Serialtest Async ST Async
Serialtest Spy ST Spy
Serialtest Async+Spy ST Async+Spy

If you have more than one copy of a product installed, the additional copies will have numbers following
the icon name.

To run Serialtest, double-click on the product icon.

The first time Serialtest is run the Hardware Settings window will appear.  At the top of the window are
radio buttons for choosing which product to run.  Boxes for choosing the COM ports you want to use are in
the middle, and cable detection and info buttons are at the bottom.  If you need to change your COM ports
in the future, double-click on the FTS Setup icon in the Frontline Test System folder or choose Hardware
Settings from the File menu on the Control window.

There are six radio buttons at the top of the Hardware Settings window.  Only the radio buttons for the
product or products you have installed will be active; the others will be grayed out.

There are three possible modes in Serialtest: Use FTS Cables, Spy, and Source DTE, No Cables.
(SerialBERT® refers to Serialtest's sister product SerialBERT, a Bit Error Rate Tester, and MLT refers to a
version of Serialtest designed for use with a Modem Line Tap device.)

•  If you have Serialtest Async with the cable set, click on the Use FTS Cables button.
•  If you have Serialtest Spy, click on the Spy button.
•  If you have both Async + Spy, you can choose either Use FTS Cables or Spy.
•  Source DTE, No Cables is available for both Serialtest Async and Spy, and allows you to transmit data

without using the cable set.  See the online Help for more information.

Click on a radio button to choose which mode to use.  Then skip to the appropriate section for the mode
you have chosen.

Use FTS Cables
Read this section if you selected Use FTS Cables in the Hardware Settings box.

Choose your COM ports
Select which COM ports you want to use in the two port boxes.  Click on the arrow to see a list of all COM
ports available on your computer.  If you want to use only one COM port, list that port in the top box, and
choose Not Used for the bottom box.

Connecting the Cables
Figure 1 shows how to connect the cables for monitoring on a PC with two serial ports.  The online help on
Cable Configuration includes diagrams and instructions for other configurations.
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Once you have connected your
cables, click on the Detect Now
button to be sure that your cables
are connected to the correct COM
ports.

Click OK when you are finished.
The Hardware Settings box will
close and Serialtest will start.

Set the I/O Configuration
Before you can begin capturing
data, you need to tell Serialtest
about the circuit you want to
monitor.  From the Control
window, open the Set I/O
Configuration window by clicking

on the Set I/O button .  Change
the settings in the Set I/O Configuration window to match those of the circuit you are monitoring, and set
the operating mode to Monitor Both. If you have one COM port, choose either Monitor DTE or Monitor
DCE.  Close the Set I/O window when you are finished.

You are now ready to begin using Serialtest to capture data.  Skip to the Quick Start Guide

Spy
Read this section if you selected Spy in the Hardware Settings box.

Spy allows you to monitor the data passing through an internal COM port or modem.  (Note: You must start
Serialtest Spy before you start the application that will be using the COM port in order to ensure that
Serialtest's driver is used by both Serialtest and the COM port.)

Choose your COM port
In the top port box, select which COM port you want to monitor.  Click on the arrow to see a list of all
COM ports available on your computer.

Click OK when you are finished.  The Hardware Settings box will close and Serialtest will start.  You are
now ready to begin capturing data.

Source DTE, No Cables
Read this section if you selected Source DTE, No Cables in the Hardware Settings box.

Source DTE, No Cables allows you to transmit data as a DTE device and monitor the DCE response
without the use of cables.  You can transmit data to an external device through a serial port or to an internal
device, such as an internal modem.

Choose your COM port
In the top port box, select which COM port you want to use.  For example, if you want to test an internal
modem, choose the COM port that the modem is connected to.  Click on the arrow to see a list of all COM
ports available on your computer.

Click OK when you are finished.  The Hardware Settings box will close and Serialtest will start.

Figure 1
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Set the I/O Configuration
Before you can begin capturing data, you need to give Serialtest the parameters of the data you want to
transmit.  From the Control window, open the Set I/O Configuration window by clicking on the Set I/O

button , or choosing Set I/O Configuration from the Window menu.  Change the settings in the Set I/O
Configuration window to match those of the device you are transmitting to.  Close the Set I/O window
when you are finished.

You are now ready to begin using Serialtest to transmit data.

Quick Start Guide
The purpose of the Quick Start Guide is to help you get up and running with a minimum of work.  The
Quick Start will explain how to begin and end data capture for the most common configuration:
monitoring a circuit.  It will also explain how to view a capture file, including Serialtest for DOS capture
files.

Serialtest is organized around a Control window.  From the Control window you have access to the
other windows used to control various aspects of the program.  In addition, data capture is also
controlled from the Control window.  Each icon on the toolbar represents a window or data capture
function.  Hold the cursor over each button, and a tooltip will pop up with the name of each button.  To
learn more about what each button does, read the help topic on the Control Window Toolbar.

How to Capture Data

The following information assumes that you are trying to monitor communications between two
devices.  This is the most common use for Serialtest.  If you need to transmit data to a device, follow the
first two steps on setting up your cables and I/O configuration, then go to the help on the Transmit
window for information on how to be a data source.  If you are running in Spy Mode, skip to the next
section on Capturing to the Buffer.

First, ensure that your cables are connected to your PC properly.  Below is a diagram of the
configuration for monitoring when you have two serial ports.  The help on Cable Configuration includes
diagrams and instructions for other configurations.
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Next, you need to tell Serialtest about the circuit you are trying to monitor.  From the Control window,

open the Set I/O Configuration window by clicking on the   button, or choosing Set I/O
Configuration from the Windows menu.  Change the settings in the Set I/O Configuration window to
match those of the circuit you are monitoring.  Also, you will need to set the operating mode to Monitor.
Close the Set I/O window when finished.

Capturing to Buffer

Data capture can be initiated from either the Control window or Live Events window.  NOTE: You do
not need to have any windows other than the Control window open to capture data.  Open the Statistics

window by clicking on the Statistics button  .  This window will show you summary information
about the events on the circuit.  Next, open the Live Events window by clicking on the Live Events

button  .  This window will show you the events as they are being captured.

To begin capturing to the buffer, click on the   button from the Control window or Live Events
toolbar, or choose Start from the Live menu.  Serialtest will start capturing events to the capture buffer.
When the buffer becomes full, it will begin to “wrap ” using the First In, First Out rule, unless buffer
wrap has been turned off in the System Settings.

NOTE: Any data that is “wrapped” out of the buffer is lost and cannot be recovered!  If you are
monitoring data and you are not sure if you will need it later or not, the safe thing to do is to be sure that
your capture buffer or file is large enough to hold your data.  If you do not want to the buffer to wrap or
need to change the size of your buffer, go to the System Settings screen.

You can pause data capture at any time by clicking on the Pause/Resume   button.  If you pause
data capture, Serialtest will not capture any data until you click on the Pause button again to resume
capturing.  If you want to save your capture buffer, you must Pause data capture first.  See Saving Your
Capture Buffer.

Reset the capture buffer by clicking on the Clear button  .  Serialtest will ask you if you really want
to reset or if it should save the data in the buffer first.  If you choose Reset, Serialtest will remove all
data from the buffer and reset data capture.  Once the buffer is cleared, the data is lost and cannot be
recovered.  Be sure to save your data if you have any doubts about whether you will need it later.

Capturing to Disk

To begin capturing to a file, click on the Capture to Disk   button or choose Start Capture to Disk
from the Live menu.  Serialtest will display a dialog box asking you what name you want to give your
file and what directory you want to save it in.  Click OK when you have made your choices.  Serialtest
will open a capture file and begin capturing data.

You can pause data capture at any time by clicking on the Pause/Resume   button.  If you pause
data capture, Serialtest will not capture any data until you click on the Pause button again to resume
capturing.

When you have finished capturing data, click on the Close File button   to stop data capture.
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The maximum file size is set in the System Settings.  When the file gets full, Serialtest will either begin
overwriting the data in the file or stop data capture.  If you want Serialtest to overwrite the data in the
file, place a check mark in the box labelled Wrap Buffer.  If you want Serialtest to stop capturing data,
remove the check mark from the Wrap Buffer box.

Viewing the Data

You can use any window or combination of windows while data is being captured, or you can have no
windows open.  You can begin troubleshooting your problem right away using the Review Events

window  , while Serialtest continues to gather data in the background.  Use the Find feature 
from the Review Events window to search for a particular string or error condition.  You can also search
for control signal changes or by timestamp.  Click on the links below to find out more about each
window and its features.

You can also view a previously captured file by using View Mode.  When FTS is installed, there will be
icons for FTS Async (called Live Mode, this is where you capture data) and FTS View.  FTS View
allows you to review capture files.  To open a capture file in either mode, go to the Control window, and
choose Open from the File menu.  Then choose a capture file to open.

NOTE For Serialtest DOS Users: You can open DOS capture files in FTS.  See Loading Serialtest for
DOS Files.

Exiting Serialtest

To exit Serialtest, go to the File menu on the Control window, and choose Exit.

Installing Additional Products and Uninstalling Products
If you already have an FTS product installed, you can install additional products or uninstall a product
from the FTS Setup window.

1. Double-click on the FTS Setup icon from the Frontline Test System folder on your desktop, or click
on the Start button and choose Programs --> Frontline Test System --> FTS Setup.

2. Click on the tab labeled Setup.  This tab shows you the serial numbers and name of every installed
FTS product.

3. To install a new product, click on the Install button, and type in the serial number of the new
product.

4. To remove a product, click on the product you want to uninstall, and then click the Uninstall button.

Changing Icon Names
1. Double-click on the FTS Setup icon from the Frontline Test System folder on your desktop, or click

on the Start button and choose Programs --> Frontline Test System --> FTS Setup.
2. Click on the Setup tab.
3. Click the product whose name you want to change.
4. Click the Modify button at the bottom of the window.
5. Type in the new name for the product.
6. Click OK.
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The name of the product tab in the FTS Setup window will change, as will the name of the icon used to
start the product.

To modify the name of an add-on product, select the name of the product the add-on is attached to.

Moving Add-on Products
Add-on products add functionality to stand-alone products.  When add-ons are installed, they are attached
to a stand-alone product.  You can change which stand-alone product the add-on is attached to.

1. Double-click on the FTS Setup icon from the Frontline Test System folder on your desktop, or click
on the Start button and choose Programs --> Frontline Test System --> Setup.

2. Click on the Setup tab.
3. Click the add-on you want to move.
4. Click the Modify button at the bottom of the window.
5. Select the product you want the add-on to attach to.
6. Click OK.

Hardware Settings & Modes
Hardware Settings

The Hardware Settings box is used to tell FTS which mode you want to operate in and which COM
ports to use.  This box will appear the first time you start the program.  If you need to change your COM
ports later, you can do so at any time by choosing Hardware Settings from the File menu in the Control
Window.

You can also change the COM ports from outside the program by opening the Frontline Test System
folder on the desktop and double-clicking on the FTS Setup icon.  When the Hardware Settings box is
opened from outside FTS, you will be able to change the hardware settings for all FTS products
currently installed.  In addition, you will be able to install and uninstall products, and change the names
of the product icons.

Choosing Mode and Com Ports

Choose Mode
There are four radio buttons at the top of the Hardware Settings box.  These are: "Use FTS Cables",
"Spy Mode", "Source DTE, No Cables", and "SerialBERT Mode".  (SerialBERT is a sister product to
Serialtest that does Bit Error Rate Testing.  If you do not have SerialBERT installed, this button will be
grayed out.)

• If you have Serialtest Async with the cable set, the Use FTS Cables button will be available.
• If you have Serialtest Spy, the Spy Mode button will be available.
• If you have both Async and Spy, both buttons will be available.
• The Source DTE, No Cables button is available for all versions of Serialtest.

Click on a radio button to choose the mode you want to use.
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Choose Use FTS Cables when you want to transmit data to an external device or monitor an external
circuit using the cable set.

Use Spy Mode to "spy" on the data going in and out of an internal COM port or internal modem.

Use Source DTE, No Cables Mode to transmit data to an external or internal modem or other
communications device.

Choose COM ports
To change your COM ports, click on the down arrow in the top port box and choose one of the COM
ports listed.  This list is generated from the registry of your computer, and so it will only list the COM
ports that are available on your computer.  Next, click on the down arrow of the second box and choose
a second COM port to use.  (If you chose Spy Mode or Source DTE, No Cables Mode, you will only be
able to choose one COM port.)

If you have only one COM port on your computer, choose a port in the first box, and choose Not Used
for the second box. FTS will only allow you to choose options appropriate for single port mode once
you get into the program.

Changes in your COM ports will take effect when you click on the OK button, or the next time you start
FTS if you changed them from outside the program.

Choose Options
Detect Now button - Click to determine what cables are connected to your computer.

Notify If Auto Detect Fails - FTS will look for the cables each time data capture is started.  Uncheck this
box if you do not want FTS to look for the cables before starting capture.

Disable control signal interrupts - When checked, FTS will ignore all interrupts generated by the control
signals. This is mostly a troubleshooting tool used when monitoring a circuit which has large numbers
of rapid signal changes.

Source DTE, No Cables
Source DTE, No Cables Mode lets you transmit DTE data without using the cable set, which means that
you can transmit data directly to an internal device on your computer such as an internal modem or
COM port.  This mode is probably most useful for testing internal modems.  Using the Transmit
window, you can send commands directly to the internal modem, and use the Review or Live Events
window to see the modem's response.

To use this mode, open the Hardware Settings window and click on the radio button for Source DTE,
No Cables.  Choose which COM port you want to communicate with.  If you are testing a modem,
choose the COM port that the modem is connected to.  When you enter FTS, go to the Set I/O
Configuration window and set the baud rate, parity and other parameters.  Then go to the Transmit
window to transmit data.  You should be able to see the data transmitted, plus any response from the
device, in the Review or Live Events window.

Ring Indicator control signal changes may not always be properly captured in this mode.  See the note
on Ring Indicator changes for more information.
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Detect Now button
The Detect Now button can be used to check that the cables are attached to the correct ports.  To use the
Detect Now button, you must have your cables connected to the computer (see Cable Configuration for
help connecting your cables.) Click on the Detect Now button, and FTS will respond with a message
saying what cables it has found.  Due to limitations in cable detection, FTS will not always be able to
determine exactly which cables are connected.

Notify if Auto cable detection fails
FTS automatically checks to see if the cables are present when the software is first started, and every
time data capture is initiated.  You can turn off automatic cable detection by unchecking the Notify If
Auto Detect Fails box on the Hardware Settings window.  FTS will still look for the cables when the
program first starts up, but will not check when data capture is initiated.

This feature should be left on unless there is a reason why FTS cannot detect the cables but can still
capture data.

Connecting the Cables

Cable Configuration
The cables included with Serialtest are:

• a routing cable, which is a y-cable with a 25 pin connector on one end and two 9 pin connectors
labelled DTE and DCE on the other ends, used to connect to the monitor or source head

• a monitor head
• a source head.

All cables have their name molded into the plastic on one end.  Also included are two 25-to-9 pin
adapters to be used with computers with 25 pin serial ports.
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Dual Port Monitor Mode Cable Configuration

• Attach the DTE connector of the routing cable to one COM port, and the DCE connector to the
other COM port.

• On the end of the routing cable, attach the monitor head.  The monitor head has the words “Monitor
Head” molded into the plastic on the connector that hooks up to the routing cable.

• Place the monitor head between the two devices you wish to monitor.

Note: the monitor head is a straight-through RS-232 cable.  You can insert it between your two devices
and they will be able to communicate with each other through the monitor head, whether or not
Serialtest is running.

Dual Port Source DCE Mode Cable Configuration

• Attach the DTE connector of the routing cable to one COM port, and the DCE connector to the
other COM port.

• On the end of the routing cable, attach the source head.  The source head has the words “Source
Head” molded into the plastic on the connector that hooks up to the routing cable.  It also has the
words “DTE” and “DCE” on the other end, with arrows pointing to each side of the source head.
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• Connect your DTE device to the side of the source head marked “DCE �”.  This arrow means that
your DCE data will be coming out of this side of the source head, and so that is the side your DTE
device needs to be connected to.

Dual Port Source DTE Mode Cable Configuration

• Attach the DTE connector of the routing cable to one COM port, and the DCE connector to the
other COM port.

• On the end of the routing cable, attach the source head.  The source head has the words “Source
Head” molded into the plastic on the connector that hooks up to the routing cable.   It also has the
words “DTE” and “DCE” on the other end, with arrows pointing to each side of the source head.

• Connect your DCE device to the side of the source head marked “DTE �”.  This arrow means that
your DTE data will be coming out of this side of the source head, and so that is the side your DCE
device needs to be connected to.

Single Port Monitor DCE Mode Cable Configuration

• Connect the DCE connector of the routing cable to your COM port.
• On the end of the routing cable, attach the monitor head.
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• If you are monitoring one side of a circuit, you can connect the monitor head between your two
devices.  The monitor head is a straight-through RS-232 cable, so your 2 devices will still be able to
communicate, but Serialtest will only monitor the DCE side.

• If you are monitoring a DCE device only, connect the DCE device to either side of the monitor
head.  It does not matter which side you choose.

Note: If you are monitoring a circuit, you can switch to monitoring DTE by going into the Set I/O
Parameters screen and switching to Monitor DTE mode.  Then disconnect the DCE head from your
COM port and connect the DTE head, and you will see DTE data.  You will not need to do anything
with the monitor head cable.

Single Port Monitor DTE Mode Cable Configuration

• Connect the DTE connector of the routing cable to your COM port.
• On the end of the routing cable, attach the monitor head.
• If you are monitoring one side of a circuit, you can connect the monitor head between your two

devices.  The monitor head is a straight-through RS-232 cable, so your 2 devices will still be able to
communicate, but Serialtest will only monitor the DTE side.

• If you are monitoring a DTE device only, connect the DTE device to either side of the monitor
head.  It does not matter which side you choose.

Note: If you are monitoring a circuit, you can switch to monitoring DCE by going to the Set I/O
Configuration window and switching to Monitor DCE mode.  Then disconnect the DTE head from your
COM port and connect the DCE head, and you will see DCE data.  You will not need to do anything
with the monitor head cable.
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Single Port Source DCE Mode Cable Configuration

• Connect the DTE connector of the routing cable to your COM port.  Even though you are in source
DCE mode, you will need to use the DTE connector on the routing cable.

• On the end of the routing cable, attach the source head.
• Connect your DTE device to the side of the source head marked “DCE �”.  This arrow means that

your DCE data will be coming out of this side of the source head, and so that is the side your DTE
device needs to be connected to.

Note: You will be able to send data to your DTE device and set the DCE control signals, but Serialtest
will not be able to see any responses from your DTE device.

Single Port Source DTE Mode Cable Configuration

• Connect the DTE connector of the routing cable to your COM port.
• On the end of the routing cable, attach the source head.
• Connect your DCE device to the side of the source head marked “DTE �”.  This arrow means that

your DTE data will be coming out of this side of the source head, and so that is the side your DCE
device needs to be connected to.
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Note: You will be able to send data to your DCE device and set the DTE control signals, but Serialtest
will not be able to see any responses from your DCE device.

Using the Control Window

Control Window
FTS is organized around the Control window.  Each icon on the toolbar represents a window or data
capture function, while the status bars provide an overview of the data link at a glance.  Hold the cursor
over each button to see its name.

Because the Control window is so frequently used and because it has a tendency to get lost behind other

windows, every window has a Home   button that brings the Control window back to the front.  Just
click on the Home button to restore the Control window.

FTS has two modes: Live and View.  Live Mode allows you to capture and transmit data, and view
previously captured data.  In View Mode the data capture and transmission functions are disabled, and
you can only view previously captured data.  The Control windows for the two modes reflect the
functions that are available in each mode.

In View Mode, the title bar of the Control window shows the name of the currently open file.  The status
bar (below the toolbar) shows the Set I/O Configuration settings that were used when capturing the file.
The Control window in View Mode looks like this:

In Live Mode, the title bar of the Control window shows what hardware FTS is using.  The status bars
(below the toolbar) show the current settings from the Set I/O Configuration window, as well as a brief
summary of current operating conditions.  The Control window in Live Mode looks like this:

The bottom status bar of the Control window gives a quick look at what is currently going on.  The first
item displays the words Not Active, Paused or Running and refers to the state of data capture.  Not
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Active means that FTS is not currently capturing data, Paused means that data capture has been
suspended, and Running means that FTS is actively capturing data.

The next item shows how much of the buffer or capture file has been filled.  For example, if you are
capturing to disk and have specified a 200K capture file, the bar graph will tell you how much of the
capture file has been used.  When the graph reaches 100%, capture will either stop or the file will be
overwritten, depending on the choices you made in the System Settings.  If you are capturing to the
buffer, you will know that the buffer has wrapped when the graph reaches 100%.

The second half of the status bar gives the current utilization on the circuit for both DTE and DCE, as
well as the total events monitored on the circuit.  Note that this number is the total number of events
monitored, not the total number of events captured.  FTS is always monitoring the circuit, even when
data is not actively being captured.  These graphs allow you to keep an eye on what is happening on the
circuit, without requiring you to capture data.

The Control Window Toolbar
Available options will be in color, while unavailable options will be grayed out. All toolbar buttons have
corresponding menu items, most of which can be found in the Window menu. The exceptions are
Capture to Buffer, Capture to Disk, Pause/Resume, Clear, and Close Capture File, which are found in
the Live menu.

The buttons listed below all appear on the Live Mode toolbar.  In View Mode, only the buttons related
to viewing data are present.

 Set I/O Configuration - Use this window to tell FTS the characteristics of the circuit you are
monitoring or sourcing. Characteristics include baud, word length, parity, and stop bits.

 Capture to Buffer - Begins data capture to the buffer only.

 Capture to Disk - Begins data capture to disk.

 Pause/Resume - Available after data capture has started. Click once to pause data capture. Data
can be reviewed and saved, but no new data will be captured. Click this button again to Resume
capture.

 Clear Buffer - Stops data capture to buffer and clears the capture buffer.

 Close Capture File - Closes a capture file and stops data capture to disk.

 Live Events - Shows events as they are being captured. Note: this window requires a great deal of
processing power and may impact performance on your PC.

 Statistics - Keeps track of useful statistics such as number of bytes, average number of
characters/second, and number of errors by type.  FTS always gathers statistics, even when it is
not actively capturing data, making this screen a useful monitoring tool.  Statistics are kept on the
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entire session (the time since FTS was started) and for each set of events in the capture buffer or
file.

 Breakout Box - Functions as a passive breakout box, showing control signal changes for RTS,
CTS, DTR, DSR, CD and RI in real-time.

 Review Events - Lets you review data and do searches for errors or data patterns.  You can view
the data in hex and/or character display format, and also view other events such as control signal
changes.

 Frame Summary - Shows summary information for each data frame.  Available only if a protocol
stack is selected.

 Frame Decode - Displays a detailed protocol decode of each frame.  Available only if a protocol
stack is selected.

 Signal Display - Shows the state of the control signals over time, beginning with the first event in
the buffer or file.  You can zoom in to view control signal states for just one event, or zoom out to
view changes for the entire buffer.

 Transmit - Lets you specify what data to transmit and control signals to change.  Available only in
source mode.

 Cascade Windows - Cascades all windows (brings them home), with the first window being
placed directly below the Control window.

System Settings
Open the System Settings box by choosing System Settings from the File menu on the Control Window. To
enable a setting, click in the box next to the setting to place a checkmark in the box. To disable a setting,
click in the box to remove the checkmark.  In View Mode, settings related to data capture are grayed out.

Common Options

Wrap Buffer When enabled, FTS will wrap the buffer. The oldest events will be moved out
of the buffer to make room for new events. Any events moved out of the
buffer will be lost. This option also applies to capture files.  When disabled,
FTS will pause capture when the buffer becomes full.  Either reset the buffer
or close your capture file to continue.

Timestamping Options Opens the Timestamping Options window.  Options include enabling or
disabling timestamping and choosing capture and display resolutions.
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Save Windows on Exit When enabled, FTS will remember which windows were open and how they
were arranged, and put all the windows back in the same position the next
time FTS is started.

Automatically Save When enabled, FTS will automatically save converted DOS Serialtest
Serialtest DOS Capture .byt files to the new .cfa capture file format.  See Loading Serialtest
Files in FTS Format for DOS Files for more information.

Buffer/File Tuning Options
Capture Buffer Size (in K) Enter the maximum size of the capture buffer.  If you enter a number

larger than the maximum allowable size, FTS will warn you and
automatically set the size to the maximum allowable size.

File Size (in K) Enter the maximum size of the capture file. If you enter a number
larger than the maximum allowable size, FTS will warn you and
automatically set the size to the maximum allowable size.

Note: In both cases, FTS does not actually use 100% of available memory or disk space.  By default, FTS
will limit the maximum size of the buffer or file to 50% of the available resources.  We strongly
recommend not changing this percentage unless absolutely necessary.  If you do need to use more
resources, you can change the maximum percentage used in the Advanced Options window.  Click on the
Advanced button on the System Settings window.  If you want to change the maximum percentage for the
buffer, find the setting for Max Percent of Available Virtual Memory Used for Capture Buffer.  If you want
to change the maximum percentage for the file, find the setting for Max Percent of Free Disk Space for
Capture File.  Both of these settings are expressed as a percentage.

We strongly recommend not setting these options to 100%, as this will take all your system resources,
leaving none for any other application.

Advanced Options
These parameters affect fundamental aspects of the software, and it is unlikely that you will ever have to
change them.  If you do change them and need to return them to their original values, the default value is
listed to the right of the value box.  Most technical support problems are not related to these parameters,
and as changing them could have serious consequences for the performance of FTS, we strongly
recommend contacting technical support before changing any of these parameters.

Max Percent of Free Disk Space for Capture File
This setting determines what percentage of free hard drive space can be used for the capture file. By
default, FTS will limit the maximum size of the capture file to 50% of the available space on the hard drive.
If you need to create a larger capture file than the current settings allow, increase this percentage.  Then go
back to the System Settings window and increase the maximum capture file size.

Max Percent of Available Virtual Memory Used for Capture Buffer
This setting determines what percentage of available virtual memory can be used for the capture buffer. By
default, FTS will limit the maximum size of the buffer to 50% of the available virtual memory.  Increasing
this percentage will give you a larger capture buffer, but will leave less virtual memory available for other
applications.
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Driver Receive Buffer Size in Operating System Pages
This is the size of the buffer used by the driver to store incoming data.  This value is expressed in operating
system pages.  In Windows 95, an operating system page is 4K.

Driver Action Queue Size in Operating System Pages
This is the size of the buffer used by the driver to store data to be transmitted.  This value is expressed in
operating system pages.  In Windows 95, an operating system page is 4K.

Capture Buffer Read Cache Size in Kbytes
Sets the size of the capture buffer cache.  This setting is important when reading data.  A larger buffer may
mean faster read times.

Capture File Write-Through Cache size in Pages
Sets the size of the capture buffer write cache.  This setting is important when writing data to disk.

Return Unused Space in Capture File When Closing  (Yes/No answer)
When FTS opens a capture file, it allocates as much disk space as it needs for the maximum capture file
size.  When the capture file is closed, FTS gives back any unused space.  This process can take some time
if the maximum capture file size is large.  This setting is the threshold that determines if we give back
unused space when the file is closed.  The default value of 0 means that FTS will always give back unused
space.  One Allocation Granularity Unit is equal to 64K of space.

Maximum Number of Bytes Decoded Per Frame
This is the largest frame size that FTS will attempt to decode.  This is used to prevent FTS from attempting
to decode very large bad frames.  This number should be large enough to ensure that the largest reasonable
frame is handled completely.

Maximum Number of Bytes Used to Store Supplementary Capture File Information
Sets the amount of space used to store supplementary information in the capture file.  The default value is
100000.

Capture Buffer System Page Size Multiplier
Data in a capture file is indexed by pages to allow for faster retrieval.  The page size multiplier determines
how often the file is indexed.  The default value of 1 means that the capture file is indexed every page, or
once every 4K.

Non-Realtime Event Queue Size
This is the queue for all non-realtime events.

Protocol Stack
The Protocol Stack window is where you choose the protocol stack you want FTS to use.  FTS is able to
automatically decode higher layer protocols given a lower layer protocol as a starting point.  This means
that you usually only need to specify the bottom-most protocol in the stack, and FTS will automatically
decode higher layer protocols.  FTS calls this ability "auto traverse".

For example, if you specify Async PPP as your protocol, FTS will also decode IP and TCP data, if present
in the frame.  If you specify HDLC mod 8, FTS will also decode X.25.
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To have FTS automatically traverse the protocol stack, choose a bottom layer protocol, and then check the
Auto Traverse Stack button.  There is no need to choose more than one protocol when the Auto Traverse
Stack button is checked.

To choose a protocol, click on the protocol in the Available PDA Modules box, and click on the arrow to
move the protocol into the Protocol Decode Stack box.  You can also double click on the decode to move it
into the stack.

If no protocol is listed, FTS will not attempt to decode the data.  If you are capturing framed data, you
MUST choose the appropriate protocol before beginning data capture.

If you have a particular stack order that you want FTS to use, list your decodes in the Protocol Decode
Stack box, and uncheck the Auto Traverse Stack button.  If you choose more than one decode, you can
change its position in the stack by clicking on the decode and then clicking on the Move Up or Move Down
buttons. To remove a decode, click on the decode and then click the Remove button.

Minimizing Windows
You can choose to minimize windows individually, or have all windows minimize when the Control
window is minimized.  To minimize all windows when the Control window is minimized, go to the
Window menu in the Control window, and choose Minimize Control Minimizes All.  When this is checked,
minimizing the Control window will minimize all windows.  When this is unchecked, all windows,
including the Control window, can be minimized separately.  Windows minimize to the top of the Task
Bar.

Setting the I/O Configuration

Set I/O Configuration Window
The Set I/O Configuration window allows you to configure Serialtest for both monitor and source operating
modes.  Serialtest requires information on baud, parity, word length, and number of stop bits in order to
operate properly.  If you are capturing framed data, you MUST choose a protocol from the Protocol Stack
in order for the data to be framed correctly.

There are two rows of settings, one for the DTE device, and one for the DCE device.  Depending on your
operating mode, you will need to configure one or both sides.  Serialtest will only allow you to change the
settings relevant to your operating mode.  All other settings will be grayed-out.  Some settings apply only
to specific modes.  For example, Flow Control settings only apply in source mode.

If a configuration file is open, it will be listed at the top of the Set I/O Configuration window.  If no
configuration file is being used, Serialtest will revert to its default settings.  You can revert to the factory

default settings at any time by clicking on the Revert to Factory Defaults button   on the Set I/O
Configuration toolbar.

Operating Mode - Choosing to Monitor or Source

Monitor Mode
If you specified two COM ports in the Hardware Settings window, choose Monitor Both from the pulldown
list.  This means that Serialtest will monitor both sides of your circuit.  To do this, you must use the routing
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cable and the monitor head.  You can also choose to monitor only one side of the circuit by choosing
Monitor DTE or Monitor DCE.

If you specified one COM port in the Hardware Settings window, you will be able to monitor either the
DTE or the DCE side of a circuit, but not both.  Choose Monitor DTE or Monitor DCE from the pulldown
list to specify which side you want to monitor.

Source Mode
Serialtest can act as either a DTE or a DCE device.  Choose Source DTE or Source DCE from the pulldown
menu to specify which type of device you want to emulate.

If you have two COM ports, you will be able to send data to another device, change the state of the
appropriate control signals, and see data and control signal states from the other device.

If you have one COM port, you will be able to send data to another device and see data sent by the device.
If you are emulating a DTE device, you will be able to change DTR and RTS , and you will be able to see
changes made by your DCE device on DSR and CTS , but you will not be able to see changes on CD and
RI .  If you are emulating a DCE device, you will be able to change DSR and CTS, but not CD and RI, and
you will be able to see DTR and RTS signal changes coming from your DTE device.

You must use the routing cable and the source head when in source mode.  The device under test must be
connected to the correct side of the source head.  See Cable Configuration for assistance on setting up the
cables.

Setting Baud, Parity, Word Length and Stop Bits
To change a setting, click on the down arrow next to the setting box and choose an option from the list.  For
baud, you can either choose a listed rate or enter a rate.

Baud choices range from 50 bits per second (bps) to 115,200 bps.

Parity choices are None, Odd, Even, Mark, Space and Ignore.

Word Length choices are 5, 6, 7, and 8 bits.

Stop Bit choices are 1 and 2 bits for word lengths of 6, 7 and 8, and 1 and 1.5 bits for a word length of 5.

If you have chosen to monitor both DTE and DCE, you will have to set the configuration for both sides.  To
make things easier, you can set the configuration for the DTE side, and click on the DTE-to-DCE button

 . This will change the settings on the DCE side to match those of the DTE.  If you have chosen to
monitor only DTE or only DCE, or if you have chosen to be a source, you will only need to set the
configuration for the appropriate side.  The other side will be grayed out and you will not be able to change
those settings.

Defining Your Own Baud

To define your own rate, highlight the text in the baud field and type in a new rate.  Acceptable rates range
from 2 bps - 115.2K bps, though not all rates are supported.
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If you choose a baud that is not supported, Serialtest will display a box asking you to choose between the
two nearest supported rates.  You must choose a rate in order to continue working.

Bit Order
Choose LSB (least significant bit) first or MSB (most significant bit) first.  LSB first is normal, while MSB
first is considered "reversed" from normal.  This option reverses the order of the bits within each byte.

All options on the Set I/O window are valid when in MSB mode except for parity.  The parity must be
None when using MSB bit order.

Bit reversal occurs both when monitoring data and when transmitting data.  For example, if Serialtest is
monitoring data in LSB mode and sees 0000 0001 on the circuit, it will display this as hex 01.  In MSB
mode, Serialtest will reverse the order of the bits as they come in and display this byte as 1000 0000, or hex
$80.

When transmitting data, Serialtest reverses the bits before they are sent out over the circuit.  For example, if
you are transmitting data in LSB mode and you enter the pattern $01, Serialtest will send out 0000 0001.  If
you are transmitting in MSB mode and you enter the pattern $01, Serialtest will bit reverse this and
transmit 1000 0000.

Serialtest remembers what bit order was used to capture the data with.  If you create a capture file with the
bit order set to MSB, the data will always be displayed in that form.

If you are monitoring HDLC or SDLC data and the bit order is set to MSB, it is probable that the CRC's
will not be calculated correctly.

Flow Control
Flow control is only available in source mode.  There are three flow control options: None, Hardware, or
Software.  The default option is None.

If you choose None, Serialtest will not employ any flow control techniques.

Hardware flow control can be accomplished using either the RTS /CTS pair or DTR /DSR pair.  Choose
which pair you would like Serialtest to use.

To use software flow control, choose the XON/XOFF option.  Serialtest will use the XON/XOFF
characters given in the boxes below the flow control option.  These numbers must be specified in
hexadecimal (hex) characters.  By default, Serialtest uses hex 11 for XON and hex 13 for XOFF.

Protocol Stack
This box shows which protocol stack is currently in use.  To change the protocol you want to use, click on
the down arrow and choose a protocol from the list.  To choose a different protocol or define your own
stack, click on the Custom Protocol Stack button.  If you are capturing framed data, you MUST choose a
protocol before beginning data capture in order for the data to be framed correctly.



28

Names
Following is a list of all the labels used in Serialtest to identify errors, control signals, and DTE/DCE
devices.  To change the labels, click the Names button on the Set I/O Configuration window.  Changes to
the labels will be used throughout the program.  For example, changes to the control signal labels will be
used in the Breakout Box window.

Sides

The Sides section allows you to give your DTE and DCE devices more descriptive names.

Errors

Serialtest recognizes three types of errors: Overrun, Parity and Framing.  This section allows you to change
the error labels.

Signals

Labels for the six control signals monitored by Serialtest are given below.

Label             Control Signal
RTS Request to Send
CTS Clear to Send
DSR Data Set Ready
DTR Data Terminal Ready
CD Carrier Detect
RI Ring Indicator

If you are used to different abbreviations for the same signals, you can change them in this section.  For
example, if you normally refer to Carrier Detect as DCD, highlight CD and type in DCD.

Saving Configurations
Saving A Configuration to File
Set up your configuration on the Set I/O Configuration screen.
1. If a configuration is already open and you have altered it, go to the File menu and choose Save As;

otherwise, click on the Save Configuration button.
2. In the File name box, type a name for your configuration.  You do not need to add an extension.

Serialtest will add a .cfg extension automatically.
3. By default, Serialtest will save the configuration in your Data directory.  Choose a differentm directory

to save the configuration elsewhere.
4. Click on Save.

If you make a new configuration and do not save it, Serialtest will ask you if you want to save your
configuration when you exit the program.  If you want to save your configuration, choose Save and the
Save File dialog box will appear.  If you do not want to save your configuration, choose Cancel.
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Opening a Saved Configuration
Configurations are saved with a .cfg extension, and are located in your Data directory by default.
1. Click on the Open Configuration button.  If other configurations have been used recently, a menu

listing the last four configurations used will be displayed.
2. Select a recent configuration file, or choose Open to load an unlisted configuration.
3. If you have saved your configurations in the default directory, they will be in listed in the window.

Choose a different directory if your configurations are saved elsewhere.
4. Select the configuration you want to use, and click on Open.

The name of the open configuration file is displayed at the top of the Set I/O Configuration window.  If no
configuration file is open, “Untitled” will be displayed.

Gathering Basic Statistics

Statistics Window
The Statistics window supplies basic information about the data on a circuit.  Serialtest will collect
statistics even if data is not being captured to buffer or disk.  The Statistics window also shows
information on data being captured to buffer or disk, and a summary of the data when reviewing capture
files.  Statistics gathered include: number of events, number of bytes, number of errors, characters per
second (current and average) and utilization (current and average.)

Information about all data collected since Serialtest was started is shown in the Session tab.  The Session
tab cannot be reset; in this sense, it is like the odometer on a car.  The odometer on a car shows you all
the miles driven since the car was built, and the Session tab shows you all the data collected since
Serialtest was started.

If you think of the Session tab as the odometer, then the Resetable tab is the trip odometer.  It can be
reset, and allows you to record statistics for a new “trip.”  In this way you can effectively start a new
session without having to restart Serialtest.

The Buffer tab shows information on the data that is currently in the capture buffer.  The tab will reset
when you clear the buffer.  If the capture buffer becomes full, Serialtest will begin to throw out the
oldest data and put new data in its place.  This is called “wrapping.”  If the buffer wraps, the count for
the total number of events will remain roughly the same, since the buffer will remain full until it is
cleared and therefore always contains approximately the same number of events.

Occasionally some of the statistics will read N/A, for Not Available.  This happens for various reasons.
For example, many of the items on the Buffer tab will become N/A if the buffer should become full and
wrap.  When this happens, Serialtest can no longer provide accurate statistics for the data in the buffer,
because some of the data that the statistics are based on has been lost.

Reading the Statistics Window
Each item in the Statistics window is described in order, from the top down.

Timestamp: The current time is always displayed on the top line.  The Resetable tab will also display
the last time it was reset.
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Events: total number of events captured.  Events include data bytes, control signal changes, flow control
changes, etc.  For a description of all events and their symbols, see Viewing Events.

Bytes: total number of bytes, with a breakdown by DTE and DCE device.

Frames: total number of frames, if applicable, with a breakdown by DTE and DCE device.

Driver Buffer Overflow: number of bytes lost due to driver buffer overflow.  Buffer overflow occurs
when data is coming in too fast for Serialtest to process it.  See Performance Notes for more on buffer
overflow.

UART Overrun: number of overrun errors broken down by DTE and DCE device.  See Performance
Notes for more on overrun errors.

Parity: number of parity errors broken down by DTE and DCE device.  If you have a large number of
parity errors, check your Set I/O Configuration for accuracy.

Framing: number of framing errors broken down by DTE and DCE device.  If you have a large number
of framing errors, check your Set I/O Configuration for accuracy.

Current Chars/Sec: current number of characters per second.

Average Chars/Sec: average number of characters per second.

Current Utilization: current number of characters per second divided by the baud, expressed as a
percentage.

Average Utilization: average number of characters per second divided by the baud, expressed as a
percentage.

Peak: highest average utilization.

Baud: the baud rate selected in the Set I/O Configuration window.

The Statistics Toolbar

 Show Control Window - brings the control window to the front.

  Reset - resets the Resetable Statistics tab.

  Freeze - freezes the display.  Click once to freeze the display, and click again to resume.

 Change Font Size - click to change the font size.

 Timestamping Options – click to change how timestamps are displayed and the timestamp
resolution.
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Analyzing Data and Running Searches

Analyzing Your Data
Review Events
The Review Events window is a data review screen that provides detailed information about every captured
event.  By default, Serialtest displays the events in hex on the left side of the window, with the appropriate
characters shown on the right.  Data is displayed with DTE data appearing on a white background and DCE
data appearing on a gray background.  Labels are provided between the hex and character data to help
differentiate between DTE and DCE data.

The window is laid out like a spreadsheet.  On the left side are row labels and at the top are column labels.
16 events are shown in each row.  The labels are always displayed in hex.  Bytes with errors are shown in
red, to make them easy to spot.

Obtaining Information on Events
Click on an event to display information about it in the 3 lines at the bottom of the screen.  You can also
highlight multiple events to obtain information such as CRC and data rate.

The first line always shows the event number and the total number of events in the file or buffer on the left,
followed by the timestamp on the right (if available.)  If you have selected multiple events, the first line
gives the first and last event selected, and the timestamps of both the first and last event.  See Event
Numbering for more information on how Serialtest numbers events.

The second line has labels for the information shown on the third line.  The information on these lines
varies with the type of event and whether you are looking at one event or multiple events.  Information on a
single byte includes the source (whether DTE or DCE), character and numerical values, the state of the
control signals at the time the byte was captured, and any errors associated with the byte.  Information on
multiple events includes the data rate, the amount of time that elapsed between the first and last byte
(referred to as delta), the CRC and the state of the control signals.  A "Chg" in a control signal box
indicates that the signal changed state somewhere in the selection.

Choose CRC Method
1. Select the data to generate a CRC for by clicking and dragging the mouse to highlight the bytes you

want.
2. Click on the CRC button to bring up the CRC dialog box.
3. Click on the down arrow to show the list of choices for CRC algorithms.  Choose an algorithm to use.
4. Enter a seed value in hexadecimal if desired.
5. Click OK to generate the CRC.  It will appear in the byte information lines at the bottom right of the

Review Events screen.

Serialtest will calculate the CRC for either the DTE or DCE side.  Which side it calculates is determined by
the first byte selected.  If the first byte is from the DTE side, then Serialtest will calculate the CRC for just
the DTE bytes in the selected group.  If the first byte is from the DCE side, Serialtest will calculate the
CRC for just the DCE bytes.
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Event Numbering
This section talks about how events are numbered when they are first captured and how this affects the
display windows in Serialtest.  The information in this section applies to frame numbering as well.

When Serialtest captures an event, it gives the event a number.  If the event is a data byte event, it receives
a byte number in addition to an event number.  There are usually more events than bytes, with the result is
that a byte might be listed as Event 10 of 16 when viewing all events, and Byte 8 of 11 when viewing only
the data bytes.

The numbers assigned to events that are wrapped out of the buffer are not reassigned.  In other words, when
event number 1 is wrapped out of the buffer, event number 2 is not renumbered to event 1.  This means that
the first event in the buffer may be listed as event 11520 of 16334, because events 1-11519 have been
wrapped out of the buffer.  Since row numbers refer to the event numbers, they work the same way.  In the
above example, the first row would be listed as 2d00 (which is hex for 11520.)

The advantage of not renumbering events is that you can save a portion of a capture file, send it to a
colleague, and tell your colleague to look at a particular event.  Since the events are not renumbered, your
colleague’s file will use the same event numbers that your file does.

Saving Data
Saving Your Data
You can save all or part of a capture buffer displayed in the Review Events window.  You can also load a
previously saved capture file, and save a portion of that file to another file.  This feature is useful if
someone else needs to see only a portion of the data in your capture file.

For example, you have a ten megabyte capture file and the home office needs to see only two megabytes of
that file.  You can save only the two megabytes they need to see in a new file.

The Save button and Save menu item are grayed out while data is being captured.  You must pause capture
before saving.

Saving the Entire Capture Buffer
1. Click on the Pause   button to pause data capture.  You cannot save a buffer to file while data is

being captured.

2. Click on the Save button  .
3. Click on the radio button labeled Entire buffer.
4. Type a filename in the Save As box at the bottom of the screen.  When you are finished, choose OK.

Saving a Portion of a Capture File or Buffer
1. Select the portion of the data that you want to save.  Click and drag to select data.  You can also click

on an event to place the cursor, scroll down to the end of the area you want to select, hold down the
Shift key and click on the end event.

2. Click on the Save button  .
3. Click on the radio button labeled Selection.  (This should already be chosen by default.) Make sure the

starting and ending event numbers are correct.
4. Enter a filename in the Save As box.
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5. Choose OK.

Searching
Searching
Serialtest allows you to search your capture buffer or capture file by pattern, control signal, error, or
timestamp.  You can also move through the buffer a specified number of events at a time, or go to a
specific event anywhere in the buffer.

1. Capture some data to the buffer, or open a capture file to search.

2. Click on the Find button   or choose Find from the Data Menu.
3. The Find window has five tabs, one for each type of search.  Click on a tab to do that type of search.

Note that you can press F3 to repeat any search from the Review Events window.

Search by Pattern
Search by Pattern lets you to do a traditional string search.  You can search one or both sides of the circuit,
and your search can include wildcards.  You can combine any of the formats when entering your string.

Entering Characters

Place the cursor in the string box and type in your string.  Click Find Next in order to find the next
occurrence of the string.  You can click on Find Next as many times as necessary until Serialtest has
searched all the data.  Clicking on Find Previous will search the buffer backwards.

You can enter any character from a character set, with the following exceptions: \$&^?.  These characters
are used as prefixes to let you to enter hex, binary, control or wildcard characters.  The escape character is
the backslash \.  Use this character when you want to search for one of the above restricted characters.  For
example, to search for a $, you would enter \$.  To search for a \, enter \\.

Click on Ignore Case to do a case-insensitive search.

Entering Hex or Binary

To enter a hex value, enter a $ followed by two hex digits.  For example, to search for hex 00 01, enter
$00$01.

If you need to specify the $ as a character, you can use \$.

Just as the $ symbol tells Serialtest that the following characters are hex digits, the & symbol tells Serialtest
that a binary number comes next.  For example, to search for binary 00001111, you would use &00001111.

If you need to specify the & as a character, you can use \&.

Entering Control Characters
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The ^ (caret) is used to enter the control characters Ctrl-A through Ctrl-Z and Ctrl-@,[,\,],- when using the
ASCII character set.  For example, ^A specifies Ctrl-A ($01) and ^@ specifies ASCII NUL ($00).

If you need to specify the ^ as a character, you can use \^.

Note that neither the ^ character nor control characters exist in Baudot, so attempts to search for the ^
character will result in an error message.  The ^ character exists in EBCDIC, but control characters do not.
A search for ^A in EBCDIC will match any occurrence of ^A ($5F$C1).  You do not need to use the
escape character to search for a ^ character in EBCDIC.

Using Wildcards

The wildcard character is the ?.

Serialtest supports wildcard searching at the byte, nibble and bit level.  Wildcards can be used in place of
characters, hex digits, and binary digits.

If you need to specify the ? as a character, you can use \?.

Examples:

To search for any single byte in the range of hex $10 through $1F, type $1?.

&111111?? will search for binary numbers beginning with 111111 and ending with any combination of 1
and 0.  11111100, 11111101, 11111110, and 11111111 are all strings that match the search criteria.

To search for any four character string which starts with an L and ends with an ES, type L?ES.

You can combine formats in one string.  For example, another way to specify a search for the string L?ES
is $4C&????????&01000101S.

See Also Side Restrictions

Searching for Errors
Serialtest can search for five types of errors: Overrun, Parity, Framing, CRC and Underrun, in any
combination or singly (Serialtest Async can search for three types of errors: Overrun, Parity and Framing.)
You can choose which errors you want to search for, and you can choose whether to search just the DTE or
DCE data, or both.  Bytes with errors are shown in red in the Review Events window, making it easy to
find errors visually when looking through the data.

Serialtest takes the current selected byte as its initial condition when running searches that rely on finding
events where error conditions changed.  Serialtest will search until it finds an event where error conditions
changed or it reaches the end of the buffer, at which point Serialtest will tell you that there are no more
events found in the buffer.  If you are searching for an exact match, Serialtest will ask you if you want to
continue searching from the beginning of the buffer.

Selecting Which Errors to Search
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The section with the check boxes allows you to choose which errors Serialtest should look for.  If you want
to search only for overrun errors, you would check the overrun box, and uncheck the other two boxes.  To
search for all errors, check all three boxes.  Click on a box to check or uncheck it.

Searching for Error Conditions

The first three options are all fairly similar, and are described together.  These options are searching for an
event where:

• one or more error conditions changed
• one or more error conditions occurred
• one or more error conditions were off.

The most common search is looking for a few scattered errors in otherwise clean data.  To do this type of
search, choose to search for an event where one or more error conditions occurred, and then choose which
errors to look for.  By default, Serialtest will look for all five types of errors: overrun, parity, framing, CRC
and underrun.  In contrast, searching for an event where one or more error conditions were off means that
Serialtest will look for an event where the error(s) were not present.

For example, if you have data that is full of framing errors, and you know that somewhere in your 20
megabyte capture file the framing got straightened out, you could choose to search for an event where one
or more error conditions were off, and choose to search only for framing.  Serialtest would search the file,
and the find the point at which framing errors stopped occurring.

Searching for an event where the error conditions changed means that Serialtest will search the data and
stop at every point where the error condition changed from on to off, or off to on.

For example, if you have data where sometimes the framing is wrong and sometimes right, you would
choose to search framing errors where the error condition changed.  This would first take you to the point
where the framing errors stopped occurring.  When you click Find Next, Serialtest will stop at the point
when the errors began occurring again.

Searching for Exact Error Conditions

To search for an exact state means that Serialtest will find events that exactly match the error conditions
that you specify.  First choose to search for an event where your choices exactly describes the state.

This will change the normal check boxes to a series of radio buttons labeled On, Off and Don’t Care for
each error.  On means that the error occurred, Off means that the error did not occur, and Don’t Care means
that Serialtest will ignore that error condition.  Choose how you want the error conditions to look like by
clicking in the radio boxes.

Example:

If you need to find an event where just an overrun error occurred, but not a parity or framing error, you
would choose overrun error to be On, and parity and framing to be Off.  This will cause Serialtest to look
for an event where only an overrun error occurred.

If you want to look for events where overrun errors occurred, and parity and framing errors may have also
occurred but it really doesn’t matter if they did or not, choose overrun to be On, and set parity and framing
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to Don’t Care.  Serialtest will ignore parity and framing errors or the lack thereof, and find events where
overrun errors occurred.

To find the next error, click the Find Next button.  To find an error that occurred previous to where you are,
click the Find Previous button.

Control Signal Searching
Control signal searching allows you to search for changes in control signal states for one or more control
signals.  You can also search for a specific state involving one or more control signals, with the option to
ignore those control signals whose states you don’t care about.

Serialtest takes the current selected byte as its initial condition when running searches that rely on finding
events where control signals changed.

Selecting Control Signals to Search

The section with the check boxes allows you to specify which control signals Serialtest should pay
attention to when doing the search.  Serialtest will pay attention to any control signal with a check mark.
Click on a box to place a check mark next to a control signal, and click again to uncheck the box.  By
default, Serialtest will search all control signals, which means all boxes start out checked.

For example, if you are only interested in finding changes in RTS and CTS, you would check those two
boxes and uncheck all the other boxes.  This will tell Serialtest to look only at the RTS and CTS lines when
running the search.  The other signals will be ignored.

Searching for On, Off, or Changed States

The first three options are all fairly similar, and are described together.  These options are searching for an
event where:

• one or more control signals changed
• one or more control signals changed from off to on
• one or more control signals changed from on to off.

Searching for an event where one or more signals changed means that Serialtest will look at every control
signal that you checked, and see if any one of those signals changed state at any time.  If you want to look
at just one control signal, for example RTS, you would check the RTS box and uncheck all the other boxes,
and then choose to search for an event where one or more signals changed.  Serialtest will note the state of
RTS at the point in the buffer where the cursor is, search the buffer, and stop when it finds an event where
RTS changed state.  If the end of the buffer is reached before an event is found, Serialtest will tell you that
no matches were found.

Searching for events where control signals changed state from off to on, or vice versa, is most useful if the
signals are usually in one state, and you want to search for occasions where they changed state.  For
example, if DTR is supposed to be on all the time but you suspect that DTR is being dropped, you would
tell Serialtest to look only at DTR by checking the DTR box and unchecking the others, and then do a
search for where one or more control signals changed from on to off.  Serialtest would search the DTR
signal and stop at the first event where DTR dropped from on to off.

Searching for an Exact State
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To search for an exact state means that Serialtest will find events that match exactly the state of the control
signals that you specify.  First choose to search for an event where your choices exactly describe the state.

This will change the normal check boxes to a series of radio buttons labeled On, Off and Don’t Care for
each control signal.  Choose which state you want each control signal to be in.  Choose Don’t Care to have
Serialtest ignore the state of a control signal.

When you click Find Next, Serialtest will search for an event that exactly matches the conditions selected,
beginning from the currently selected event.  If the end of the buffer is reached before a match is found,
Serialtest will ask you if you want to continue searching from the beginning.  If you want to be sure to
search the entire buffer, place your cursor on the first event in the buffer.

Example

If you need to find an event where RTS, DSR and DTR are on, CTS is off and you don’t care about the
state of CD and RI, you would set the buttons as illustrated.

Searching By Time

Absolute vs. relative timestamp searches

An absolute timestamp search means that Serialtest will search for an event at the exact date and time
specified.  If no event is found at that time, Serialtest will go to the nearest event based on the “Go to the
timestamp” selection.  A relative search means that Serialtest will begin searching from whatever event you
are currently on, and search for the next event a specified time away.  Use the radio buttons to indicate
which type of search you would like to do.
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Absolute Timestamp Search

Specify the time to search for using the counters in the middle of the window.  Click on the arrows next to
each item to increase or decrease the value of each counter.  By default, the counters are filled in with the
timestamp of the first event in the buffer.  When you have finished selecting your time to search for, click
on the Go To button to start the search.

Sometimes there can be more than one event with the same timestamp.  Serialtest will highlight all events
with the same timestamp.

Relative Timestamp Search

Click on the event in the Review Events window that you want to begin your search from.  The event must
have a timestamp in order for relative timestamp search to work.  In the Find window, specify the time
interval you want to jump using the counters in the middle of the window.  You can specify intervals in
days, hours, minutes, seconds, and fractions of a second, or any combination of these.  When you have
specified the time interval you want to use, click on the Move Forward or Move Backward buttons to start
the search from the current event.

For example, to search for an event occurring 10 seconds after the currently selected event, choose to do a
relative timestamp search, use 10 seconds for your time interval, and click on Move Forward.

As with absolute timestamping, Serialtest will highlight all events with the same timestamp.

Choosing "On or Before" or "On or After"

Serialtest will search for an event that matches the time specified.  If no event is found at that time,
Serialtest will go to the nearest event either before or after the specified time.  Choose whether to have
Serialtest go to the nearest event before the specified time or after the specified time by clicking the
appropriate radio button in the “Go to the timestamp” box.

If you are searching forward in the buffer, you will usually want to choose the "On or After" button.  If you
choose the "On or Before" option, it may be that Serialtest will finish the search and not move from the
current byte, if that byte happens to be the closest match.

Subtleties of Timestamp Searching

Timestamping can be turned on and off while data is being captured.  As a result, the capture buffer may
have some data with a timestamp, and some data without.  When doing a search by timestamp, Serialtest
will ignore data without a timestamp.

Side Restriction
Side Restriction means that Serialtest will look for a pattern coming wholly from the DTE or DCE side.
If you choose to search without regard for data origin, Serialtest will look for a pattern coming from one
or both sides.

For example, if you choose to search for the pattern ABC and you choose to search without regard for
data origin, Serialtest will find all three instances of ABC shown below.
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The first pattern, with the A and the C coming from the DTE device and the B coming from the DCE is a
good example of how using a side restriction differs from searching without regard to data origin.  While
searching without regard for data origin will find all three patterns, searching using a side restriction will
never find the first pattern, because it does not come wholly from one side or the other.

If you choose to search for the pattern ABC, and you restrict the search to just the DTE side, Serialtest will
find the following pattern:

In this example, Serialtest will find only the second pattern (highlighted above) because we restricted the
search to just the DTE side.  The first pattern doesn't qualify because it is split between the DTE and DCE
sides, and the third pattern, though whole, comes from just the DCE side.

If we were to choose both the DTE and the DCE sides in the above example, Serialtest would find the
second pattern followed by the third pattern, but not the first pattern.  This is because each side has one
instance in which the whole pattern can be found.  Serialtest will completely search the DTE side first,
followed by the DCE side.

Side Restriction is available for pattern and error searching.

Go To Event
This type of search allows you to go to a particular event, or to move through the data X number of events
at a time.  You can move either forward or backwards through the data.



40

To go to a particular event, simply click in the box to place the cursor, and type in the number of the event
you want to go to.  Then click on the Go To button.

To move forward or backwards through the data, type in the number of events that you want to move each
time, and then click on the Move Forward or Move Backward button.  For example, to move forward 10
events, type the number 10 in the box, and then click on Move Forward.  Each time you click on Move
Forward, Serialtest will move forward 10 events.

Using the Signal Display to View Control Signals
Signal Display Window

The Signal Display window provides you with a graphical view of control signal transitions that you
can manipulate.  You can zoom in to view the state of control signals for a range of events, or zoom
out to view control signal changes over the course of an entire capture session.

The Signal Display window does not provide a real-time view of control signal changes.  It is
intended to be used as a post-process review screen.  Use the Breakout Box window to view real-time
control signal changes.  Note that if you bring up the Signal Display window while data is being
captured, the window will show you the state of the control signals at the time the window was
opened.  This is called a "snapshot" because it is a picture of the buffer at the time the Signal Display
was opened.  To update the display to reflect the current state of the buffer, use the New Snapshot

  button.

The Signal Display window will display only the control signals you are interested in.  Click the

Options   button to choose which control signals to display.

Reading the Signal Display
Control signal changes are displayed in a graphical format.  On the left side of the screen is a list of the
signals currently being displayed, and to the right of each name is a line displaying the state of the signal
over time.  A single line means that the signal was logically off, while a double line means that the
signal was logically on.  Dotted lines are used for signals that were not present at the time of capture.
For example, if you are monitoring a circuit that does not use CD, that line will appear as a dotted line in
the control signal display.

The four information lines at the bottom of the window tell you what events are being shown in the
window, and where you are in relation to the buffer as a whole.  The first line tells you what event
numbers are in the current snapshot, the total number of events, and the amount of time that passed
between the first event in the snapshot and the last event (called Delta).

The second line gives the same information about the events that are currently visible in the window.
Because you can zoom in and out, often the events being shown in the window are not the same as the
number of events in the current snapshot.

The third line gives the same information for the currently selected events.  You can highlight a range of
events by clicking at any point on the graphical display and dragging the mouse to the left or the right.
The third line will show information for the selected range.
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The fourth and last line shows the exact timestamps of the first and last bytes in the currently selected
range.  Note that this does not tell you the timestamp for the entire snapshot or the events displayed in
the window, just the highlighted events.

A single mouse click will place the cursor in the window.  FTS highlights all six signal changes in one
color, and uses a different color to specify the control signal line clicked on.  You can highlight a range
by clicking and dragging the mouse to the right or left.  You can also use the arrow keys to move the
cursor to the right or left.

The Signal Display window is synchronized with other windows in FTS.  A range highlighted in the
Signal Display window will also be highlighted in the Review Events, Frame Decode and Frame
Summary windows.

The Snap to Nearest Change button   lets you place the cursor on the signal change you want to
look at without needing to click on exactly the right spot.  Find the line corresponding to the control
signal you want to look at.  Click on the line, and FTS will move the cursor to the nearest change.  If
you highlight a range, FTS will "snap to" the nearest changes on either side.  This feature is active when
the Snap To button is pressed, and inactive when the button is not pressed.

Use the Zoom In and Zoom Out buttons to increase and decrease the magnification of the window.  FTS
will change the magnification by a factor of 2, 4 or 8, depending on the option selected in the Signals
menu.

If you want to see a range in greater detail, highlight the range you want to view and click on the Zoom

to Selection    button.  FTS will zoom in to show only that range in the window.  If the range is
small, FTS may add additional events to fill up the window.  To view the entire snapshot in the window,

click on the Display Entire Buffer   button.

Note that if you bring up the Signal Display window while data is being captured, the window will show
you the state of the control signals at the time the window was opened.  To update the display, use the

New Snapshot   button.

Signal Display Options
Choose which control signals to display in the Signal Display window.  A check mark next to a control
signal name means that the signal will be displayed.  Click on a box to check or uncheck it.

The Signal Display Toolbar
 Show Control Window - Bring control window to the front.

 Take New Snapshot - Takes a new "picture" of the capture buffer.  If you are capturing data when you
open the Signal Display window, the window will show only the state of the control signals that were in
the buffer when the window was opened.  Click this button to update the window with the contents of the
current buffer.

 Zoom In - "Zooms in" on the signal display.  How much you zoom in is determined by your selection in
the Signals menu.  You can zoom in by a factor of 2, 4, or 8.
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 Zoom Out - Reverse of Zoom In.

 Zoom to Selection - Zooms to show only the region highlighted on the screen.  If the highlighted area
contains few events, the Signal Display window may also display additional events in order to fill up the
screen.

 Display Entire Buffer - Zooms all the way out to display the contents of the entire buffer in the window.

 Find - Opens the Find Control Signal change window.

 Options - Open the Signal Display options window, where you can change which control signals are
displayed in the window.

 Snap to Nearest Change - Moves the cursor to the nearest signal change whenever you click on the line
graphics in the window.  Find the line for the control signal whose changes you want to see.  Click on that
line, and FTS will move to the nearest signal change for that control signal.  You can also highlight a
range, and FTS will snap to the 2 nearest changes on either side of the range.

 Timestamping Options – Opens the Timestamping Options window, where you can change the
timestamping resolution and how timestamps are displayed.

Data Formats and Symbols
Timestamping Options
The Timestamping Options window lets you enable or disable timestamping, and change the resolution of
the timestamps for both capture and display purposes.  Select Timestamping Options on the View menu of
the Review Events or Live Events window to open the Options window, or click the Timestamping Options
icon   on the toolbar.

Enabling/Disabling Timestamping

Check the Store Timestamps box to enable timestamping.  Remove the check to disable timestamping.  If
you disable timestamping, you will not be able to do delta or rate calculations.

Capture Options

Change the resolution used to timestamp captured data in the Storage Resolution box.  Note that if you
change the resolution, you will need to exit FTS and restart in order for the change to take effect.

This option affects the resolution of the timestamp stored in the capture buffer or capture file.  The default
timestamp is 10 milliseconds for Windows NT and 1 millisecond for Windows 95/98.  These values are
determined by the operating system and are the smallest "normal" resolutions possible for each operating
system.
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It is also possible to use "high resolution" timestamping.  High resolution timestamp values are marked as
high resolution in the drop down list.  Note that high resolution timestamping may not be available on all
Windows 9x systems.

Display Options

The options in this box affect only how the timestamps are displayed on the screen, not the resolution used
to capture the data.

Display Relative Timestamps will show the timestamp as the amount of time that has passed since the first
byte was captured.  It works just like a stop watch in that the timestamp for the first byte is 0:00:00.0000
and all subsequent timestamps increment from there.  The timestamp is recorded as the actual time, so you
can flip back and forth between relative and actual time as needed.

Number of Digits to Display changes the number of digits used to display fractions of a second.  Again, this
option does not affect the resolution of the timestamp stored in the capture file, it only affects the resolution
displayed on the screen.

Switching Character or Number Sets
Options for data display include:

Number formats - hex, binary, octal and decimal
Character sets - ASCII , 7 bit ASCII, EBCDIC and Baudot .

By default, Serialtest will display data in hex and ASCII.  To change the number or character set, go to the
Data menu on the Control window and highlight your choice.  A check mark next to a character or number
set indicates which set is currently being used.

In the Review and Live Events windows, you can also right click on the header labeled Hex, and choose a
number format from the list.  To change the character set, right click on the header labeled ASCII, and
choose a character set from the list.

If you want to see only the numerical values, click on the Numbers Only button  .  If you want to see

only the characters, click on the Characters Only button  .  Click on the button again to return to both
numerical and character display.

List of All Event Symbols
By default, Serialtest shows all events.  If you want to view only the data bytes, click on the All Events

button  .  Click again to view all events.

In addition to data bytes, the events shown are (in alphabetical order):

 Abort

 Broken Frame

 Buffer Overflow

 Control Signal Change



44

 Data Capture Paused

 Data Capture Resumed
 End of Frame

 Flow Control Active

 Flow Control Inactive

 Frame Recognizer Change (a protocol that frames the data was selected or removed here,
causing the frame recognizer to be turned off or on)

 I/O Configuration Change

 Long Break

 Low Power (ComProbe only)

 Short Break
 Spy Mode Event (Spy only)
 Start of Frame

 Begin Sync Character Strip (ComProbe only)

 End Sync Character Strip (ComProbe only)

 Sync Dropped (ComProbe only)

 Sync Found  (ComProbe only)

 Sync Hunt Entered  (ComProbe only)

 Sync Lost  (ComProbe only)

 Test Device Stopped Responding  (ComProbe only)

 Test Device Began Responding  (ComProbe only)

 Timestamping Disabled

 Timestamping Enabled

 Underrun Error  (ComProbe only)

 Unknown Event

Mixed Sides
If you want to get more data on the screen, you can switch to mixed sides mode.  This mode puts all the
data together on the same line.  DTE data is shown on a white background and DCE data is shown on a
gray background.

Click once on the Mixed Sides button   to put the display in mixed sides mode.  Click again to return
to DTE over DCE mode.

You can also right click on the DTE/DCE labels in the center of the data display window to change
between mixed and DTE over DCE modes.  Choose Display Sides Together to go to Mixed Sides Mode,
and Display Sides Separately to go to DTE over DCE mode.
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Font Size
1. Click on the Font Size button  .
2. Click on the down arrow to choose a font size from the list.
3. Click OK.

You can also change the font size by positioning the mouse cursor over the grid lines on the left side of
the window.  When the cursor is positioned properly, it will change to a double arrow.  Click and drag
down to increase the font size, or drag up to decrease the font size.

Analyzing and Decoding Frames

Frame Decode
The Frame Decode window is a post-process review screen that provides a detailed decode of each
frame.  The decode is presented in a layered format that can be expanded and collapsed depending on
which layer(s) you are most interested in.

A decode layer that contains more information will have a small box with a plus sign next to the layer
name.  To expand the layer, click on the box.  The layer will expand and the plus sign will change to a
minus sign.  To collapse the layer, click on the minus sign.

Use the left and right arrow buttons to move through the frames.  To move to a specific frame, click on

the Go To button  .  In the dialog box, type in the number of the frame you want to go to, and click
on the Go To button.  Serialtest will move to that frame.  Click on the Move Forward and Move Back
buttons to move the number of frames specified in either direction.  For example, if you enter 10 in the
frame box and click Go To, Serialtest will move to frame number 10.  If you click Move Forward,
Serialtest will move forward 10 frames.

The Frame Decode window is synchronized with the Review Events and Frame Summary windows.
The frame currently displayed in the Frame Decode window will be highlighted in the Frame Summary
window.  Click on any part of the decode, and the Review Events window will highlight the
corresponding bytes in the data.

Copying an Entire Frame Decode
• Go to the Frame you want to copy.
• From the Edit menu, choose "Copy Entire Frame".

A copy of the entire frame decode will be placed on the clipboard, where it can be pasted into another
application.

Frame Summary Window
The Frame Summary window contains a one-line summary of every frame in a capture buffer or file.
Information for each frame may include a timestamp (if available), the Type, the Length, the ID and
Offset, the Protocol, the Source and Destination Addresses, plus other summary information, as
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applicable.  The background color of the one-line summary indicates whether the frame came from the
DTE or the DCE device. Frames with a white background come from the DTE device, while frames
with a gray background come from the DCE device.

Summary information is shown for one protocol at a time. The header on the left side of the window
shows what protocol information is currently being displayed.  To change the protocol, right click on the
header and choose a new protocol from the list.  You can also go to the View menu and select Choose
Displayed Protocol.  Click on the down arrow to see a list of available protocols.

The status bar at the bottom of the screen shows the frame number and the total number of frames,
whether the frame came from the DTE or DCE device, and the timestamp.

The Frame Summary window is synchronized with the Review Events and Frame Decode windows.
Click on a frame in the Frame Summary window, and the bytes for that frame will be highlighted in the
Review Events window while the Frame Decode window will display the full decode for that frame.

Frames in red mean that one or more bytes within the frame have errors associated with them.  A frame
marked “Bad Frame” means that the frame has a bad Frame Check Sequence Number (FCS).

Bad frames will not be tagged in all protocols.  For example, if you are decoding IP running over PPP
and a frame comes through with a bad Frame Check Sequence number (FCS), the bad frame will not be
tagged when showing the IP data because there is no error in the IP data. The FCS error will be tagged
when showing the PPP data.

In order for the frame summary window to be correct, the data must have been captured with the
appropriate protocol stack selected.  When a protocol that uses frames has been selected, Serialtest runs
the data through a frame recognizer as it is being captured.  The frame recognizer marks the beginning
and end of frames.  If no protocol stack was selected, no frame recognition was done when the data was
captured, and Serialtest will not be able to display the frames.

Go to Frame
1. Click on the Go To Frame   button or choose Go to Frame from the Edit menu.
2. Type in the Frame number and click on Go To.
3. You can also jump a specified number of frames at a time.  For example, to move ten frames in

either direction, type "10" in the box and then click on Move Forward or Move Back.  Serialtest
will move ten frames forward or back.

Viewing Data Capture in Real-time

Live Events
The Live Events window allows you to view data as it is being captured.  The window is continually
updated with incoming data (see Data Capture Options to change the rate at which Serialtest updates the
window.) You can freeze the window to view pertinent information while still capturing data in the
background.  To view information on a particular byte, click on the byte and information will be
displayed in the three byte information lines at the bottom of the window.
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As a general rule, use the Review Events window rather than the Live Events window while capturing
data because you can browse through the entire buffer and run searches, which you cannot do from the
Live Events window.  Using the Review Events window also places less of a processing load on the PC.
If you find that you have overrun errors or buffer overflows in your data while using the Live Events
window, try reducing the Window Refresh Rate or using the Review Events window instead.  See
Performance Notes for more information on maximizing performance.

Capture Options

Window Refresh Rate

Serialtest’s first priority is capturing all the data that comes through the ports.  Its second priority is
updating the screen to reflect the new data.  This option sets the rate at which Serialtest will update the
screen.  The default setting is once every 1000 milliseconds, or once every second.

Changing the rate to a slower update rate will give the computer more time to process incoming data.
This can help ensure that Serialtest captures all the data if you are monitoring a high speed circuit with a
lot of data on it.  However, it also means that the screen update might look a bit jerky.

Changing the rate to a faster rate will make the screen update more smoothly, but puts an increased
processing load on your PC.  This can cause Serialtest to drop data, resulting in overrun errors and/or
buffer overflow errors.  If Serialtest is dropping data, try changing the rate to a slower update rate.

Data Capture Options

The remaining options govern what Serialtest does when it starts up.  Serialtest can immediately begin
capturing data to disk, begin capturing to the buffer, or not do anything at all.

Note: Serialtest will always collect statistical information, and the breakout box will always work as
soon as the window is opened, regardless of whether Serialtest is set to capture data immediately or not.

If you choose to start capturing to disk immediately, the options asking about filenames will become
available.

Generate unique filename means that Serialtest will come up with a unique filename and use that for the
capture filename.

Prompt for filename means that Serialtest will bring up a dialog box asking you for a filename and
where you want to file to be stored.

Always use means that Serialtest will always use the filename you enter for the capture file.  If you
choose this option, you must also choose whether Serialtest should append data to any existing data in
the file, or overwrite any old data with new data.

The Live Events Toolbar

 Home – brings the Control window to the front.
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The next five buttons on the toolbar control data capture.  These buttons correspond to the same buttons
on the Control window toolbar, and perform exactly the same functions.

 Capture to Buffer - Begins data capture to the buffer only.

 Capture to Disk - Begins data capture to disk.

 Pause/Resume - Available after data capture has started.  Click once to pause data capture.  Data
can be reviewed and saved, but no new data will be captured.  Click again to Resume capture.

 Clear Buffer - This will clear the capture buffer and stop data capture to buffer.

 Close Capture File - This will close a capture file and stop data capture to disk.

The next two buttons allow you to freeze the screen and change Capture Options.

 Freeze Display - Freezes the window so you can review a portion of data.  Data capture will
continue in the background.  Click on the button again to unfreeze the window.  When you do
this, the screen will quickly fill in the data captured since the screen freeze and jump you down to
view incoming data again.

 Options - Brings up the Capture Options window.  This window allows you to change the window
refresh rate and set startup capture options.

The next six buttons all deal with how information is presented on the Live Events screen.  These buttons
mirror the same buttons in the Review Events screen.

 Mixed Sides - By default, Serialtest shows data with the DTE side above the DCE side.  This is called
DTE over DCE format.  DTE data has a white background and DCE data has a gray background.
Serialtest can also display data in mixed side format.  In this format, Serialtest does not separate DTE data
from DCE data but shows all data on the same line as it comes in.  DTE data is still shown with a white
background and DCE data with a gray background so that you can distinguish between the two.  The
benefit of using this format is that more data will fit onto one screen.

 Character Only - Serialtest shows both the number (hex, binary, etc.) data and the character (ASCII,
EBCDIC or BAUDOT) data on the same screen.  If you do not wish to see the hex characters, click on the
Character Only button.  Click again to go back to both number and character mode.

 Number Only - Controls whether Serialtest displays data in both character and number format, or just
number format.  Click once to show only numeric values, and again to show both character and numeric
values.

 All Events - Controls whether Serialtest shows all events in the window, or only data bytes.  Events
include control signal changes and framing information.

 Font Size - Brings up the Font Dialog box, allowing you to change the font size.

 Timestamping Options – Brings up the timestamping options window which has options for customizing
the display and capture of timestamps.
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The Breakout Box
Breakout Box Window
The Breakout Box window provides a real-time graphical view of control signals.  The window is
customizable based on the control signals you wish to view and your preference of indicators (+/-, 1/0,
T/F, arrows, and simulated LEDs).  Also included are counters showing the number of times a control
signal has changed.

FTS monitors six RS-232 control signals.  These are:

DTE Signals
DTR - Data Terminal Ready
RTS - Request to Send

DCE Signals
CTS - Clear to Send
DSR - Data Set Ready
CD - Carrier Detect
RI - Ring Indicator (see the special note on capturing Ring Indicator changes)

Reading the Breakout Box Window
The Breakout Box display is divided into three main parts.  The first part (to the far left of the screen)
shows the abbreviated name of the control signal being monitored.  These names can be changed in the
Set I/O Configuration screen by choosing Names.
The second part shows the control signal counters.  The counters show how many times each control
signal has changed state.  This is useful in situations when signals may be changing state too often to be
displayed graphically.

The third part of the Breakout Box shows the current states of the control signals.  The indicators show
the state that the control signal is currently in, and the line graph displays the state of the signal over
time.  A single line means that the signal is logically off, while a double line means that the signal is
logically on.  A half-height “tick” means that a signal has gone through one full transition (from off to
on to off, or vice versa) since FTS last updated the screen.  The RTS line in the above picture shows an
example of a half-height “tick.”

To change the indicators or the rate at which FTS updates the window, click on the Options 
button.

Breakout Box Options

Display Signal
This box shows which control signals FTS monitors.  A check mark next to a control signal name
indicates that the breakout box will display the status of that control signal.  To prevent FTS from
displaying the status of a signal, uncheck the box next to it.

Window Refresh Rate
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The refresh rate is the rate at which FTS updates the window.  By default, FTS refreshes the display
once every 1,000 milliseconds (one second.) To change the rate, highlight the number in the box and
enter a new number.  See Performance Notes for information on how Window Refresh Rate can affect
performance.

Indicators
You can choose what type of indicators FTS will use.  The default indicators are a green “+” sign to
show a logically high state, and a red “-“ sign to show a logically low state.  To change the indicators,
click on the down arrow and choose a pair of indicators from the list.  As a reminder, FTS gives the
definition of the indicators in the top part of the Breakout Box window.

Transmitting Data

Transmit Window
The Transmit Window is used to tell Serialtest what string or file you want to transmit.  In order to
transmit data, you must first go to the Set I/O Configuration window and choose either Source DTE or
Source DCE as your Operating Mode.  The Transmit button will become available only when this has
been done.

Transmit String
• Type the string you want to send in the string box.  Serialtest will interpret your string on the basis

of whatever character set is currently active.  Click on the History button   to the right of the
string window to choose a previously used string.

• Click on the appropriate radio button to choose how many times you want to transmit your string.
You can transmit once, transmit multiple times, or transmit continuously.  If you choose to transmit
multiple times, type in the number of times you want to send the string in the box to the right of the
Times to Transmit line.

• Click on either the Capture to Buffer   or Capture to Disk   buttons to activate the Send
button.

• Click on the Send   button to transmit your string.  If you chose to transmit once or multiple
times, Serialtest will send your string and then stop transmitting.  If you chose to transmit

continuously, Serialtest will send the string until you click on the Pause   button or the Stop

  button.

Transmit String Formats
Note that any of the formats below can be combined.  It is legal to transmit the ASCII string
ABC$65$30, for example.

Entering Normal Text Characters

Serialtest will send your string in whatever character set you are currently using.  To change the
character set, go to the Data menu in the Control Window, and choose a character set.

Examples:
To send the string “qwerty”, you would type qwerty.
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To send the string “hello, world”, you would type hello, world.

Entering Characters in Hex

To transmit in hex, type a $ in front of your two digit byte.  The $ symbol tells Serialtest that you are
sending in hex.  If you want to send more than one hex byte, you will have to type the $ symbol in front
of each byte.

You must have a two digit hex number after the $ for Serialtest to interpret the bytes as hex properly.
Otherwise, Serialtest will interpret the characters as if they belonged to a character set.  For example, if
you want to send an ASCII NUL, which is hex 00, and you type $0, Serialtest will send hex 24 followed
by hex 30.  The $ symbol is hex 24 in ASCII, and zero is hex 30.  To send a hex 00, you must type $00.

Example:
To send hex 31 00 97, you would type $31$00$97.

Entering Control Characters

The ^ symbol is used to specify that what follows is a control character.  You can transmit the control
characters Ctrl-A through Ctrl-Z, and Ctrl-@, Ctrl-[, Ctrl-\, Ctrl-], and Ctrl--.  For example, ^A will send
Ctrl-A ($01) and ^@ will send ASCII NUL ($00).

The Escape Character

The \ is the escape character.  It is used when transmitting special characters, in order to specify that the
next character should be taken literally.  These special characters are: $^&*()\.  For example, to put an *
in a string, enter \*.  To transmit a \, enter \\.

Specifying a Range of Characters

You can also send a range of characters by placing two periods between your first and last characters.
For example, A..I will generate the string ABCDEFGHI.   It is important to note that A..I in ASCII is
very different from A..I in EBCDIC.   In ASCII, A..I is equivalent to $41..$49, while in EBCDIC A..I is
equivalent to $C1..$C9.   It is also legal to specify a descending range.   For example, I..A will generate
IHGFEDCBA.

Subexpressions

Subexpressions are enclosed in ().  The parentheses are not part of the subexpression and will not be
transmitted.  For example, (ABC) yields ABC.  Subexpressions are useful because you can specify a
repeat count for them using the *.  For example (ABC)*3 will yield ABCABCABC.

Entering Baudot Characters

Since Baudot is only 5 bits it includes two shift characters.  Shift In ($1F) means interpret all following
characters as letters; Shift Out ($1B) means interpret all following characters as figures (punctuation,
numbers, control codes, etc.)  When the analyzer is activated it assumes the letters mode.   The shift
characters are captured in the buffer just as other bytes.  In source mode Serialtest automatically
supplies the shift characters to the string you enter.  For example, if you are in letter mode and enter the
string 12AB, Serialtest will send $1B (Shift Out), $17 (1), $13 (2), $1F (Shift In), $03 (A), $19 (B).
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NOTE: When you use hex notation to input a Baudot string, Serialtest will not insert shift characters.

More Examples

Enter                         To Generate
\\\$\^\(\)\* \$^()*
\$.ABC. $.ABC.
(ABC)*3\9 ABCABCABC9
($6b..$68)*2 kjihkjih
(A(BC)*2)*3 ABCBCABCBCABCBC
Aa..iZ AabcdefghiZ

Transmit File
Serialtest will transmit files as is.  For example, if you transmit a text file, Serialtest will send the text
characters, but will also send any formatting instructions such as carriage returns, tab characters, etc., as
their hex equivalents.

Serialtest capture files must first be exported to binary format before being transmitted.  Serialtest
capture files are in a special format, and if you transmit a Serialtest capture file in its native format, what
you will see will bear no resemblance to the data you want to transmit.  See Transmitting Serialtest
Capture Files for more information.

• Type in the name of the file you want to send in the File to Transmit box, or click the Browse 
button to locate your file.

• Click on the appropriate radio button to choose how many times you want to transmit your file.
You can transmit once, transmit multiple times, or send the file continuously.  If you choose to
transmit multiple times, type in the number of times you want to send the file in the box to the right
of the Times to Transmit line.

• Click on either the Capture to Buffer   or Capture to Disk   buttons to activate the Send
button.

• Click on the Send   button to transmit your file.  If you chose to transmit once or several time,
Serialtest will send your file and then stop transmitting.  If you chose to transmit continuously, click

on the Pause   button to pause transmitting, and the Stop   button to stop transmitting.

Transmitting Serialtest Capture Files
To transmit the data in a Serialtest capture file, you will first need to export it to a binary format.

• Open the capture file containing the data you want to transmit.
• On the Control window, choose Export from the File menu.
• Choose Binary Output.
• In the Fields Available box, choose Char/Event Name, and Click the Add button to add it to the

Displayed Fields box.  Remove any other fields in the Displayed Fields box.
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• Choose a filename in the Export box.  The default file name will be the name of your capture file
with a .bin extension.

• By default the file will be saved in the Data directory.  Click on the Browse button to save your file
to another location.

• If you want to transmit just DTE data or DCE data, be sure to filter out the side you do not want.
Also, you will probably want to filter out Special Events.

• Click Export.

The result will be a .bin file, which you can transmit from the File tab of the Transmit window.

Flow Control When Transmitting
Flow Control is enabled in the Set I/O Configuration window.  When flow control is active, Serialtest
will wait for a specified condition before sending data.  This feature will typically be used for testing
printers, stat muxes, and other devices which must throttle the data flowing to them.

Serialtest supports both software and hardware flow control.  Software flow control uses the XON and
XOFF values specified in the Set I/O Configuration window.  This means that if Serialtest receives an
XOFF character while in source mode it will stop sending data until an XON character is received.  DC1
and DC3 ($11 and $13 respectively) are most often used for software flow control.  If you need to use
other characters, simply enter the hex values that you want to use in the flow control boxes on the Set
I/O Configuration screen.

Serialtest supports both RTS/CTS and DTR/DSR hardware flow control.  Selecting RTS/CTS means
that Serialtest will use the RTS/CTS control signals to control data transmission.  When sourcing DTE
Serialtest will automatically assert RTS and send data when CTS is asserted.  While CTS is not asserted,
Serialtest will NOT send data.  When Serialtest is finished sending data, it will deassert RTS.  In DCE
mode Serialtest will reverse the meaning of RTS and CTS, responding to RTS as the flow control
indicator even though this is a non-standard use of the signal.

Selecting DTR/DSR tells Serialtest to use the DTR/DSR control signals for flow control.  When
sourcing DCE Serialtest will automatically assert and deassert DSR and will respond to DTR.  When
sourcing DTE Serialtest will automatically assert and deassert DTR and respond to DSR.

Changing Control Signals
Next to the transmit string or file box are boxes for changing control signal states.  You will be able to
change control signals only for the device which you are emulating.  For example, if you are a DTE
source, you will only be able to change RTS and DTR.  If you are a DCE source, you will be able to
change CTS, DSR, CD and RI.

To change a control signal, click on the box.  A check mark means that the signal is high, while an
empty box means that the signal is low.

Delays and Max Burst Size
When Serialtest transmits data, it first puts the data to be sent in a transmit buffer, and then sends the
data out the serial port.  There is a limit on the amount of data that can fit into the transmit buffer at one
time.  The Max Burst Size option allows you to control how many bytes are put into the transmit buffer
before the data is transmitted, while the Delays allow you to control the timing of data bursts.
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Max Burst Size

Max Burst Size allows you to control how many bytes are put into the transmit buffer at a time.

Example: Assume that the transmit buffer can hold up to 1000 bytes.  If the Max Burst Size is set to
1000, Serialtest would fill up the buffer with 1000 bytes and then send the 1000 bytes.  However, if you
want to send only 500 bytes at one time, you would set the Max Burst Size to 500.  Serialtest would put
only 500 bytes into the transmit buffer before sending them, even though the buffer could hold up to
1000 bytes.

String and File Delays

String Delay inserts a delay between each transmission of a string.  To set this type of delay, click on the
radio button for String Delay.  Type a value in the box to tell Serialtest how long to set the delay, and
then click on the down arrow to choose a time increment of milliseconds, seconds or minutes.  A delay
of 0 (zero) means that Serialtest will not insert a delay.

Example: A delay of 45 seconds will cause Serialtest to transmit the string, wait 45 seconds, and
transmit the string again.  This pattern will repeat until either the string has been transmitted the
specified number of times, or the user chooses to stop transmitting.

File Delay works in exactly the same way as String Delay.

Burst Delay

Burst Delay will insert a delay between each transmission of the transmit buffer.  Remember that the
Max Burst Size option effectively sets the size of the transmit buffer.  Serialtest will fill the buffer with
data up to the Max Burst Size, and send the data.  If a Burst Delay is set, Serialtest will pause the length
of the delay, before filling up the transmit buffer again and repeating the process.

To set the size of the burst, type how many bytes to send in the Max Burst Size box.  Set the delay by
typing in the length of the delay in the Burst Delay box, and then choose a time increment of
Milliseconds, Seconds or Minutes from the pulldown menu.

Example: You want to send 1000 bytes, wait 2 minutes, and repeat the pattern.  Type in 1000 in the
Burst Size box, and set the delay to 2 minutes.  Serialtest will send 1000 bytes, using as many repetitions
of the string or file as necessary to achieve the correct number of bytes, wait 2 minutes and send the
string again.

Example: You want to send a 1000 byte file continuously, and insert a five second delay between each
transmission of the file.  However, you also want to send the file in increments of 400 bytes each, with a
ten second delay between each group of 400 bytes.  To set this up, you would set your Max Burst Size
to 400, your File Delay to five seconds, and your Burst Delay to ten seconds.

Serialtest would send 400 bytes, wait ten seconds, send 400 bytes, wait ten seconds, send 200 bytes,
wait five seconds (because the end of the file has been reached), and repeat the process until
transmission was paused or stopped.
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The Transmit Toolbar
 Capture to Buffer - Begins data capture to the buffer.  You must begin capture to either the buffer or a file

before you can transmit.

 Capture to Disk - Begins data capture to a file.  You must begin capture to either the buffer or a file before
you can transmit.

 Send - Tells Serialtest to begin transmitting.

 Pause Transmitter - Pauses transmission.  While transmitting is paused, Serialtest does not send data but it
will continue to capture data coming from the other device.

 Stop Transmitting - Stops data transmission.  Serialtest will continue to capture data.

 Transmit Options - Brings up the options window, which lets you change the transmit priority.

Pause Transmit
Pause temporarily halts data transmission.  When transmission is resumed, Serialtest continues to send the
rest of the data.  Stop halts transmission completely, and any unsent bytes are thrown away.  For example,
if you are sending the ASCII string ABCD, and you paused transmission after AB had been sent, Serialtest
would remember that it needed to send the CD.  When transmission is resumed, Serialtest would send the
CD.  However, if you stop transmission after the AB has been sent, Serialtest will throw away the CD.  If
you start transmission again with the same string, Serialtest will transmit the string from the beginning.

Transmit Options
The Transmit Priority determines how much of a priority the system places on transmitting data versus
updating the screen.  On slower PC's, so much processor time can be taken up transmitting data,
especially at higher data rates, that the screen never updates, making it appear that the PC has locked up.
The Transmit Priority slider bar determines how much time to take transmitting data.  When the
Transmit Priority is high, Serialtest will ensure that data gets transmitted before it updates the user
interface.  If the Transmit Priority is low, Serialtest will allow the user interface more time.

Loading Capture Files

View Mode
View Mode allows you to view previously captured data.  View Mode looks and works exactly the same
as Live Mode, only it does not include the features that pertain solely to capturing data.  You can load
capture files made with any version of FTS and you can load capture files made with Serialtest for DOS.

An advantage of View Mode is that you can open more than one session at a time, allowing you to
review two capture files side by side, or capture data in Live Mode while using View Mode to look at a
different capture file.

Another advantage of View Mode is that you can send View Mode to anyone who needs to see your
data, and they will be able to open your capture file and see exactly what you are seeing.  The easiest
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way to send someone View Mode is to make copies of the installation disks, have the other user install
the software and use “demo” as the serial number.

If you entered View Mode using the FTS View icon, initially you will have only the Open File button
and the About button on the toolbar.  Click on the Open File button to open a capture file.  When a
capture file is open, the toolbar will change to include only those features that you need to review data.
These are: Set I/O Configuration, Close File, Statistics, Review Events, Frame Summary, Frame Decode
and Cascade Windows. The Set I/O Configuration and Statistics windows are included to show you
information about the data in the capture file.  You will not be able to reset either window or change any
information in them.

If you entered View Mode from Live Mode (i.e. by loading a capture file from Live Mode), you can
return to Live Mode by choosing Go Live from the File menu of the Control window.  If you entered
View Mode using the FTS View icon, you will have to open a program icon (ST Async, ST ComProbe,
etc) to enter Live Mode.

Loading a Capture File
• From the Control Window, go to the File menu.
• Choose a file from the recently used file list, or choose Open to load a new file.
• Capture files have a .cfa extension.  Browse if necessary to find your capture file.  Click on your

file, and then click Open.

Loading Serialtest for DOS Files
Serialtest for DOS capture files are loaded in the same way as Serialtest for Windows files.

• From the Control Window, go to the File menu.
• Choose a file from the recently used file list, or choose Open to load a new file.
• Serialtest for DOS capture files usually have a .byt extension.  Browse if necessary to find your

capture file.  Select your file, and then click Open.

Serialtest will automatically convert your DOS file into an FTS file.  The DOS file will still exist and
will still be readable by the DOS version of Serialtest.

Serialtest can decode the protocols in your DOS capture file.  When you first open the file, Serialtest
will bring up the Protocol Stack box and ask you what protocol decodes, if any, you want to use.  You
must choose a protocol decode at this point for Serialtest to decode the data in the file.  If you open a file
without using any decodes, and decide later that you want to apply a decode, you will have to close the
capture file, reopen it and choose a decode when the Protocol Stack box appears.

If the DOS capture file uses a decode that the current version of FTS does not support, the Protocol
Stack box will display "Unsupported: ?#"  where the # symbol stands for a number.  FTS will most
likely be able to display the file, but the full decode may not be available.

Large DOS capture files can take some time to convert into FTS format, and it is sometimes desirable to
convert a file only once, and then save it as a .cfa file.  To save a DOS file as an FTS file, go to the
System Options screen and enable the Convert old capture files option.  When this option is enabled,
Serialtest will convert your DOS file and save it as a .cfa file.  You can use the FTS Import Utility if you
have very large DOS files or a lot of files that you want to convert.  The utility can convert files more
quickly than FTS can.
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Printing

Print Preview
The Print Preview shows you how the data will look printed.  You can scroll through the pages and
zoom in on the data to get a closer look.  The line of buttons across the top of the window controls the
functions of the window.

To open the Print Preview window, choose Print Preview from the File menu in any window that
supports printing.  When Print Preview is chosen, the preview display replaces the regular data display
in the window.

You can print directly from the Print Preview window.  Click on the Print button to bring up the print
window.

Use the Next Page and Prev Page buttons to navigate through the data.  Next Page will show you the
next page in your data will look, while Prev Page will take you back to the previous page.

Two Page will change the display to show two pages of data.  When in the Two Page display, the button
will read One Page.  Click on the One Page button to return to viewing one page.

Zoom In and Zoom Out allow you to change the magnification of the pages.  Click on the Zoom In to
increase the magnification, and on Zoom Out to decrease the magnification.  When you have reached
the limit in either direction, the buttons will be grayed out.

You can also zoom in and out by clicking on the page itself.  When the cursor looks like a magnifying
glass, you can click on the page to increase the magnification.  When you have reached the top level of
magnification, the cursor will change back to an arrow.  Click on the page to return to normal
magnification.

Click on the Close button to return to the regular display.

Review Events Printing
1. Open the Review Events window, if not already open.
2. Make sure the data you want to print is displayed in the window.  Load a capture file if necessary.
3. From the File menu, choose Print.
4. Choose the correct printer and number of pages, and click OK to begin printing.

Frame Decode Printing
1. Open the Frame Decode window, if not already open.
2. Make sure the frame decode you want to print is displayed in the window.  Load a capture file if

necessary, and choose the correct frame.
3. Expand any decodes you want to see.  FTS will print the window exactly as it is seen on the screen.
4. From the File menu, choose Print.
5. Choose the correct printer and number of pages, and click OK to begin printing.
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Troubleshooting Printing Problems
Some printer drivers may not be able to handle the FTS True Type fonts correctly in the default mode.
When this happens, the printer driver substitutes other fonts for the FTS fonts, resulting in printed data
that does not look like the data on the screen.  Many printers have several options for handling True
Type fonts.

Changing how your printer handles True Type fonts can often be done from the Printer Properties box.
Printer Properties can be reached by choosing Printers from the Settings menu on the Start button, and
then right-clicking on your printer and choosing Properties.  It can also be reached from the Print
window within FTS.  Click on the button labelled Properties next to the name of the printer in the Print
window.

Every printer handles font substitution a little differently, and every printer puts the font settings in a
different place.  If you cannot easily find the font settings for your printer, please refer to your printer's
documentation for help.

Export
The export feature allows you to export your capture files or capture buffer to text or binary format.

Text format is used to create readable text files, which can be printed as is or imported into database
programs or spreadsheets.  Binary format creates a binary file which can be read by custom applications.
The ftsrdexp.h file is a C/C++ header file which will give you the structure of the binary file.  You can
use this file to write your own data manipulation programs.

1. To begin exporting, go to the Control or Review Events windows, and choose Export from the File
menu.

2. Select Text Output to create text files, and Binary Output to create binary files.
3. Select the fields you want included in the export file.  Click on a field in the Available Fields box,

and then click Add to add the field to the list of Displayed Fields.  The Preview box at the bottom of
the window will show you what fields you have added and how they will look in the export file.
(The Preview window uses dummy data, not actual data from your capture buffer.)

4. Select a filename.  The default filename for text files is export.txt for a capture buffer or
capture_file_name.txt for a capture file. Similarly, default filenames for binary files end in a .bin
extension.  Underneath the file name, FTS will show you approximately how big the file will be,
and what percentage of free disk space it will take up.

5. Click on the Export button to begin exporting.  Depending on the amount of data to be exported, the
export process may take some time.

By default, your export file will be saved in the Data directory.  Click on the Browse   button if
you want to save the export file to another location.

You can choose to export the entire capture buffer or just a portion of it.  If you have the Review Events
window open and have selected a range in it, the export window will automatically fill in the range for
you.

Export Fields
Available fields are:
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Byte Number number of the data byte
Decimal decimal value of the data byte
Char/Event Name character value of data bytes, or name of non-data bytes
Errors includes any errors associated with bytes
Event Number number of the event (see Event Numbering for why Byte Number and Event

Number may be different)
Frame Number number of the frame the event is in
Hexadecimal hexadecimal value of the data byte
Octal octal value of the data byte
Side shows whether the byte originated from the DTE or DCE side
Signals gives the state of the control signals
Timestamp shows the timestamp of the event
Type shows whether event was Data or a Special Event (anything other than a data

byte)

Export Filter Out
You can filter out data you don't want or need in your text file.  In the Filter Out: box, you choose to
filter out the DTE data, the DCE data or neither side (don't filter any data.)  For example, if you choose
the radio button for DTE data, the DTE data would be filtered out of your export file and the file would
contain only the DCE data.

You can also filter out Special Events (which is everything that is not a data byte, such as control signal
changes and Set I/O events), Nonprintable characters or both.  If you choose to filter out Special Events,
your export file would contain only the data bytes.  Filtering out the nonprintable characters means that
your export file would contain only special events and data bytes classified as printable.  In ASCII,
printable characters are those with hex values between $20 and $7e.

Export Templates
Once you've set up an export format, you can save all your options as a template and use it for future
exports.

1. To create a template, set up all the options on the export window exactly as you want them to be in
the template.

2. Type a name in the Apply Template box, and click Save Template.
3. To retrieve your template, click on the down arrow next to the Apply Template box, and choose

your template from the list.

To delete a template, choose the template in the Apply Template box, and click the Delete Template
button.  There are several templates supplied with FTS that cannot be deleted.  These are: CSV, Quoted
CSV, Transmit DTE, Transmit DCE, Sample Report, and Excel/Access.

Other Export Options

Use Footer This option is valid only when doing a binary export.  If you are
exporting a capture file for the purpose of retransmitting the data,
uncheck this box.  If you will be manipulating the data using the
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sample export program, check this box.  If the data is exported
without the footer, the sample export program will not be able to
read the export file.

Use Abbreviated Event Names Check this box to abbreviate the names of the Special Events.
This is useful to conserve space in the text file.

Separate Records with CR/LF Specifies whether to separate each record with a carriage
return/line feed.  If this option is unchecked, the data will be
output as a continuous stream.

Align Columns Check this box to have the columns be left-justified.

Put Fields in Double Quotes Check this box to put double quotes around the data in each field.

Output Header Includes a header at the top of the file with the date and time the
file was exported, name of the original capture file or capture
buffer, and the event numbers and timestamps for the range
exported.

Output Field Name Record Includes a record at the top of the file with the field names.

Align Field Names with Data Aligns the field name column with the data columns.

Timestamp Format Sets the timestamp format.  Native format is the month/day/year
plus hour:minute:second:millisecond AM/PM in twelve hour
format.  For other formats, "D" stands for day, "H" stands for
hour, "M" stands for minute, "S" stands for second and "m"
stands for millisecond.

Character Set Choose ASCII, EBCDIC or Baudot. (See note on exporting
Baudot.)

Signals Characters Defines how control signal states are indicated. Choose from 1/0,
T/F, or X/space. "X", "1" and "T" indicate an "on" or "high"
signal state.

Errors Characters Defines how error conditions are indicated.  Choose from 1/0,
T/F, or X/space.  "X", "1" and "T" indicate that an error occurred.

Field Delimiter Defines how the fields will be separated.  Choices are None (no
delimiter will be used), Comma, Tab, Space, Bar and Semicolon.
If a delimiter is chosen, FTS will include the delimiter between
each field in the export file.

Export Header File
The structure of the binary output file is contained in ftsrdexp.h.  This file is a C/C++ header file and is
located in the Export Samples directory.  The ftsexprt.h file should give you all the information you
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need about the structure of the binary output file to write a program to manipulate the data.  The
advantage of choosing binary output over text output is that the resulting file is much smaller than the
corresponding text file would be.

Exporting Baudot
When exporting Baudot, you need to be able to determine the state of the shift character.  In a text
export, the state of the shift bit can be determined by the data in the Character field.  When letters is
active, the character field will show letters and vice versa.

For binary export, the shift bit is stored in the same byte with the error bits.  The location of the shift bit
is documented in ftsrdexp.h.

Spying on Internal Ports (Spy Mode)

Spy Mode
Spy Mode lets you run Serialtest on a computer, and "spy" on the data going in and out of a COM port
or internal modem.  This means that you can run both Serialtest and a communications application on
the same computer, and use Serialtest to monitor the conversation between the application and another
device.  Since internal modems look like COM ports to the computer, Serialtest can monitor data
passing through an internal modem as well as a regular COM port.

There are some limitations on using Spy Mode.  Serialtest uses a custom version of the standard serial
device driver in order to "spy" on COM ports and internal modems.  This means that Serialtest must be
started before the communications application to ensure that Serialtest's driver is being used by both
Serialtest and the application.  As a corollary, the port you are monitoring must normally use the
standard serial driver, and not a custom driver.

To enter Spy Mode, you must follow the steps below in the order given.

For Serialtest Spy:
1. Start FTS.  FTS must be started before the application you are monitoring is started, or the

application will not use the correct driver and FTS will not be able to monitor the port.
2. Start the application.  Be sure to have the application use the same COM port as the one chosen for

FTS.
3. Monitor data.
4. Close your application when finished.   If you want to monitor another application, repeat steps 2-4.
5. Close FTS.

For Serialtest Async+Spy, or Async with the Spy Add-on:
1. Start FTS.  FTS must be started before the application you are monitoring is started, or the

application will not use the correct driver and FTS will not be able to monitor the port.
2. From the File menu on the Control window, choose Hardware Settings.
3. Click on the radio button labeled Spy Mode.
4. Select the COM port you want to monitor.
5. Exit the Hardware Settings window.
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6. Start the application.  Be sure to have the application use the same COM port as the one chosen for
FTS.

7. Monitor data.
8. Close your application when finished.   If you want to monitor another application, repeat steps 6 -

8.
9. Close FTS.

It is important to follow the steps in the order given because this ensures that Serialtest's driver is the
one being used by the application you are monitoring.  Please note that Serialtest's driver is designed to
behave like the standard serial driver when used by any other application.  However, because it is not
the standard serial driver, total compatibility cannot be guaranteed.  See The Serialtest Driver for more
information.

The use of FIFO buffers may cause incorrectly sequenced data when in Spy Mode.  See FIFOs in Spy
Mode for more information.

Spy Mode Settings on the Set I/O Window
Most of the settings on the Set I/O Configuration window are grayed out in Spy Mode because they will be
determined by the application using the COM port.  Serialtest will update these settings to reflect changes
made by the application, allowing you to see the actual settings being used by the application.

If you are monitoring framed data, you will need to choose a protocol stack in order to ensure that the data
is framed correctly.  You can also choose whether to monitor both sides of the circuit, or just the DTE or
DCE side.

You also have the option of choosing to monitor all incoming data, regardless of whether the application
you are spying on is running, or you can choose to monitor only when the application has opened the COM
port and is actively communicating through the port.  By default, Serialtest will monitor all data, all the
time, which means that Serialtest may show captured data before you have opened your application.  To
monitor the port only when the application has opened it, check the "Capture Only When Spied Port is
Open" box on the Set I/O Configuration window.

FIFOs in Spy Mode
The 8250 UART generates an interrupt every time a byte enters the UART.  If the UART is receiving
data at a high rate of speed, it will generate frequent interrupts which the central processor will have to
deal with, leaving the central processor less time for other tasks.  If the central processor cannot retrieve
the bytes quickly enough, data will be lost as new data overwrites the information stored in the UART.
The solution to this problem was the development of new UART chips that had buffers.

The 16550 UART, one of the most common UARTs currently in use, has a 16 byte buffer.  The buffer
operates on the First In, First Out (FIFO) principle.  The first byte in the buffer will be the first byte to
go out of the buffer.  The buffer allows the UART to store bytes until a specified number of bytes have
come in, at which point it generates an interrupt telling the central processor to retrieve the data.  The
ability to store bytes means that the UART is not generating as many interrupts, giving the central
processor more time for other tasks.

There are two problems with the buffering system and Spy Mode.  One is that data may not be
timestamped accurately, and the other is that control signal states may not be correct.  Serialtest
timestamps the byte and records the state of the control signals at the time it retrieves the byte from the
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UART.  If the buffers are being used, an interrupt will not be generated until several bytes have already
come in, possibly resulting in incorrect timestamps and signal states.

Serialtest solves the problem by telling the UART to generate an interrupt every time a byte comes in,
but Serialtest cannot do this when operating in Spy Mode.  In Spy Mode, the application being spied on
has control of the UART and specifies how the buffers will be used.  The result is that the captured data
may not be completely accurate.

If you are using Spy Mode, we recommend turning off the FIFOs on the UART if accurate recording of
timestamps or control signal states is important.

How to Turn Off the FIFO Buffers in Windows 95/98
1. Click on the Start button and choose Settings -> Control Panel.
2. Double-click on the System control panel icon.
3. Click on the Device Manager Tab, and then double-click on the Ports listing.
4. You should now see a list of the COM ports on your machine.  Click on the port you will be using

Spy Mode with, and then click on the Properties button at the bottom of the window.
5. Click on the Port Settings tab, followed by the Advanced button at the bottom of the screen.
6. Uncheck the box labeled “Use FIFO buffers (requires 16550 compatible UART)”.
7. Click OK on all windows to close the windows.
8. Follow this same process to turn the FIFOs back on.

How to Turn Off the FIFO Buffers in Windows NT
1. Click on the Start button and choose Settings -> Control Panel.
2. Double-click on the Ports control panel icon.
3. Select the port you want to use Spy Mode with, and then click the Settings button.
4. Click the Advanced button.
5. Uncheck the box labeled "FIFO Enabled."
6. Click OK to close the windows.  You will need to restart your computer for the changes to take

effect.
7. Follow this same procedure to turn the FIFOs back on.

Technical Info and Support
The following information is provided to assist you with troubleshooting problems both with FTS and
communications circuits.

Contacting Technical Support
Technical support is available in several ways.  The answers to many questions can be found in the
online help.  Frontline’s web site has documentation on common problems, as well as software upgrades
and utilities to use with our products.

Web: http://www.fte.com, go to the Technical Support Area
FTP Site: ftp.fte.com
Email address: tech_support@fte.com
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If you need to talk to a technical support representative, support is available between 9am and 5pm,
Eastern time, Monday through Friday.  Technical support is not available on national holidays.

Phone: 800-359-8570
804-984-4500

Fax: 804-984-4505

Performance Notes
As a software-based product, the speed of your computer’s processor affects Serialtest’s performance.
Overrun errors and buffer overflows are indicators that Serialtest is unable to keep up with the data.  The
information below describes what happens to the data as it comes in the port, what the two types of errors
mean, and how various aspects of Serialtest affect performance.  Also included are suggestions on how to
improve performance.

Data captured by the serial port first goes into the buffer of the UART chip of the serial port.  The UART
generates an interrupt, which tells the Serialtest driver to check the port.  The driver takes the data from the
UART and counts each byte as they are put into the driver’s own buffer.  The driver tells Serialtest that data
is ready to be processed.  Serialtest takes the data from the driver’s buffer and puts the data into the capture
buffer.

Overrun errors occur when the data in the buffer of the UART is not retrieved before new data comes in.
In this case, Serialtest knows that it has lost information but it does not know how much.  Serialtest
indicates overrun errors in the Review Events screen by marking a byte near the overrun in red.  You can
search for overrun errors using the Find feature.

Driver buffer overflow errors occur when the data in the buffer of the driver is not retrieved before new
data comes in.  Since the driver counts the bytes as it retrieves them from the UART, it not only knows that
it has lost data, it also knows how much.  Buffer overflows are indicated in the Review Events screen by a
plus sign within a circle.  Clicking on the buffer overflow symbol will show how many events have been
lost.  The Statistics window is an good place to check for buffer overflow errors.

Both overrun errors and buffer overflows indicate that data is coming in too quickly for Serialtest to
process.  There are several things that you can do to try and solve this problem.

1.  Serialtest’s number one priority is capturing data; updating windows is secondary.  However, updating
windows still takes a certain amount of processor time, and may cause Serialtest to lose data while the
window is being updated.  Some windows require more processing time than others, because the
information being displayed in them is constantly changing.  These windows are (in rough order of
processing time taken): Live Events, Breakout Box, Statistics, Review Events and Frame Overview.

Close some or all of the above windows while Serialtest is capturing data.  Serialtest can capture data with
no windows other than the Control Window open.

2.  Increase the value of the window refresh rate for any windows you have open while capturing data.
This will decrease the frequency of window updates, leaving more time for capturing data.  Changing the
refresh rate can be done from the Options screen in each window.

3.  If you suspect or know that your circuit has control signals that are changing very rapidly, go to the
System Options screen and choose to Disable Control Signal Interrupts.  This will prevent Serialtest from
capturing control signal changes on an interrupt basis, giving more time for capturing byte data.  (You can



65

use the counters in the Breakout Box to help determine if a control signal is changing quickly.)  Serialtest
will still note the state of the control signals whenever a byte is captured.  You must restart Serialtest for
this change to take effect.

4.  Close all other programs that are doing work while Serialtest is running.  Refrain from doing searches in
the Review Events window or other processor intensive activities while Serialtest is capturing data.

5.  Timestamping takes up processor time, primarily not in timestamping the data, but in writing the
timestamp to the buffer or file.  Try turning off timestamping from the Timestamping Options window.

6.  Capture to the buffer instead of capturing to disk.  Writing data to the buffer is faster than writing to
disk, allowing more time for capturing data.

7.  Change the size of the driver buffer.  This value is changed in the fts.ini file.  First, go to the Control
Window and choose System Options from the File menu.  When the dialog box appears, click OK to close
it.  This will write all of the default options to fts.ini.  Exit Serialtest.  Next, go to the directory containing
Serialtest and open the fts.ini file in any text editor.  Go to the section marked [System] and look for the
line reading “DataDriverBuffSize.”  Take the value listed there and double it.  Save your changes and
restart Serialtest.

NOTE: This procedure might help buffer overflow errors, but will not help overrun errors.

8.  Slow down the speed of the communications circuit, if possible.

If you are still experiencing overruns and/or buffer overflows after trying all of the above options, then you
may need to use a faster PC.

Performance Issues For High Resolution Timestamps
There are two things to be aware of when using high resolution timestamps.  The first is that high
resolution timestamps take up more space in the capture file because more bits are required to store the
timestamp.  Also, more timestamps need to be stored than at normal resolutions.

For example, if 10 bytes of data are captured in 10 milliseconds at a rate of 1 byte per millisecond, and the
timestamp resolution is 10 milliseconds, then only one timestamp needs to be stored for the 10 bytes of
data.  If the resolution is 1 millisecond, then 10 timestamps will need to be stored, one for each byte of data.
If you have two capture files, both of the same size, but one was captured using normal resolution
timestamping and the other using high resolution, the normal resolution file will have more data events in
it, because less room was used to store timestamps.

You can increase the size of your capture buffer or file in the System Settings.

The second issue is that using high resolution timestamping may affect performance on slower machines.
Under Windows NT, Serialtest makes a system call to KeQueryPerformanceCounter to implement high
resolution timestamping.  The equivalent call in Windows 9x is VTD_Get_Real_Time.  The note below is
from Microsoft's Device Driver Kit (DDK) for Windows NT, but the same concept applies to Windows 9x.

Use this routine sparingly, calling it as infrequently as possible. Depending on the platform,
KeQueryPerformanceCounter can disable system-wide interrupts for a minimal interval.
Consequently, calling this routine frequently or repeatedly, as in an iteration, defeats its purpose of
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returning very fine-grained, running time-stamp information. Calling this routine too frequently
can degrade I/O performance for the calling driver and for the system as a whole.

However, this note was written several years ago, and it does not define what is meant by frequently.  No
changes in performance have been noted in our tests as a result of using high resolution timestamping, but
if you experience performance problems, try using a normal resolution for your timestamps.

The Serialtest Driver
Serialtest uses custom versions of the standard Windows 95/98 and NT drivers in order to capture data.
When Serialtest first starts, it finds the standard serial driver file and makes a copy of it.  Then Serialtest
copies its own driver into the place of the standard driver.   This ensures that Serialtest is using its own
driver while running, enabling it to capture data and control signal information.  To other devices, the
driver should appear to be the standard serial driver.

Windows 95/98 and Windows NT are different in how they handle the serial driver.  Click on the
appropriate link below to find out more information for your operating system.

Windows 95/98 Driver
Serialtest uses a custom driver which is compatible with serial.vxd, the standard serial driver supplied
with 95/98.  The Serialtest driver is called serial9x.fts and is found in the Frontline Test System
directory.

When Serialtest starts, it checks the serial.vxd driver in the Windows\System directory to see if the
driver is Frontline’s or not.  If serial.vxd is not Frontline’s driver, Serialtest makes a backup copy of the
driver called serialVXD.standard and puts it in the Frontline Test System directory.  It then copies
serial9x.fts to the Windows\System directory and renames it serial.vxd.

If Serialtest finds that serial.vxd is actually Frontline’s driver, Serialtest displays a warning message
explaining that Frontline’s driver is being used as the standard driver.  The warning message lets you
know that for one reason or another, Frontline’s driver was not removed from the Windows\System
directory the last time Serialtest shut down.

To summarize, before Serialtest starts up, the driver in the Windows\System directory is called
serial.vxd and usually is the standard driver supplied by Microsoft.  This driver is approximately 19K in
size.  After Serialtest starts up, the driver in the Windows\System directory is still called serial.vxd, but
is Frontline’s version of the driver, which is larger than Microsoft’s driver.  In the Frontline Test System
directory are two files, serial9x.fts (another copy of the Frontline driver) and serialVXD.standard, which
is your original driver.

When you exit Serialtest, this process is done in reverse, putting your original driver back into the
Windows\System directory and removing Frontline’s driver.  In this way, the Windows\System
directory is kept clean.  Serialtest keeps a copy of your original driver in the Frontline Test System
directory.

If the driver swap procedure does not complete normally, you might have to make sure that all drivers
are back in the proper place.  If the only problem is that the drivers never got switched on exiting, you
can start Serialtest, note the warning message, and then exit gracefully.  This will put your original
driver back in the Windows\System directory.
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If your original driver becomes corrupted, a copy of the driver is kept in the Frontline Test Sytem
directory and is called serialVXD.standard. You can copy serialVXD.standard into your
Windows\System directory and rename it serial.vxd.  If your Frontline driver becomes corrupted, you
can reinstall the software from the distribution disks, or call Frontline for assistance.

Windows NT Driver
Serialtest uses a custom driver which is compatible with serial.sys, the standard serial driver supplied
with NT.  The Serialtest driver is called serialnt.fts and is found in the Frontline Test System directory.

In Windows NT, the serial driver is automatically started when NT starts.  In order for Frontline's driver
to be started, the standard driver must be "stopped" first.  When Serialtest opens, it issues a Stop
command to the standard serial driver.  If the stop is successful, Serialtest makes a backup copy of the
standard driver, calls it serialsys.standard and puts it in the Frontline Test System directory.  It then
copies serialnt.fts to the Winnt\System32\drivers directory and renames it serial.sys.  Once Frontline's
driver is in place, Serialtest issues the command to start the driver before bringing up the user interface.

When you exit Serialtest, this process is reversed.  Serialtest stops Frontline's driver, puts the standard
driver back into the Winnt\System32\drivers directory and starts the standard driver.  In this way, the
Winnt\System32\drivers directory is kept clean and the machine returned to its original state.  Serialtest
keeps a copy of your standard driver in the Frontline Test System directory.

The above process is what occurs if no other applications are using the serial driver at the time Serialtest
is opened or closed.  However, if other applications are using the driver when Serialtest tries to stop it,
things are more complicated.

If another application is using the serial driver when Serialtest issues the Stop command, NT will wait
until the application using the driver is finished before executing the Stop.  Serialtest checks to see if the
driver has stopped before beginning the driver switch process.  If Serialtest sees that the serial driver has
not been stopped, it displays a message box saying that it was unable to stop the serial driver and then it
will exit.

The complication is that once the Stop command is issued, there is no way to retract it.  This means that
when all applications are finished with the serial driver, NT will stop the driver.  If you try to start
Serialtest while another application is using the serial driver, Serialtest will issue the Stop command, see
that the driver is still loaded and close itself, but the Stop command will still be executed when the other
application is finished.  In order to use any serial devices after this, you will have to manually restart the
serial driver.  Note that if you close the other application and restart Serialtest, it will recognize that
there is no driver loaded, and go ahead and load its own.

Similarly, if you start Serialtest, and then start another application that uses the serial driver, both
Serialtest and the other application will be using Frontline's driver.  If you close Serialtest while the
other application is still running, Serialtest will issue the Stop command to stop the Frontline driver and
execute the driver switch.  Serialtest checks to see if the Frontline driver has been stopped.  If not,
Serialtest displays a warning message.  When the other application using the driver exits, NT will stop
the serial driver.  In order to use any serial devices after this, you will need to manually restart the serial
driver.  Note that if you restart Serialtest, it will recognize that there is no driver loaded, and go ahead
and load its own.

Restarting the serial driver

1. Click on the Start button, and choose Settings -> Control Panel.
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2. Double-click on the Devices icon.
3. Select the Device called "Serial" and then click the Start button.

If your original driver becomes corrupted, a copy of the driver is kept in the Frontline Test Sytem
directory and is called serialsys.standard. You can copy serialsys.standard into your
Winnt\System32\drivers directory and rename it serial.sys.  If your Frontline driver becomes corrupted,
you can reinstall the software from the distribution disks, or call Frontline for assistance.

Note Concerning Ring Indicator
The following information applies only if you are using Spy Mode or Source DTE, No Cables Mode.
When using the FTS cables to capture or source data, Ring Indicator is routed to a different pin which
generates interrupts normally.

There is a special case involving Ring Indicator (RI) and computers with 8250 UART s or UARTs from
that family where the state of RI may not be captured accurately.  Normally when a control signal changes
state from high to low or low to high, an interrupt is generated by the UART, and FTS goes to see what has
changed and record it.  Ring Indicator works a little differently.  An interrupt is generated when RI changes
from high to low, but not when RI changes from low to high.  If Ring Indicator changes from low to high,
FTS will not know that RI has changed state until another event occurs that generates an interrupt.  This is
simply the way the UART works, and is not a deficiency in the software.

To minimize the chance of missing a Ring Indicator change, FTS polls the UART every millisecond to see
if RI has changed.  It is still possible for FTS to miss a Ring Indicator change if RI and only RI changes
state more than once per millisecond.

UARTs in the 8250 family include 8250s, 16450s, 16550s and 16550 variants.  If you have any questions
about the behavior of your UART and Ring Indicator, please contact technical support.

FTS Import Utility

FTSIMPRT.EXE takes a foreign capture file and converts it to FTS format.  You will not lose the
original file in the conversion process.  Currently, this utility supports conversion of Serialtest Async for
DOS .byt files into Serialtest Async for Windows 95 .cfa files.

This utility is run from the command line.

To convert a foreign capture file to FTS format, type the following at the command prompt:

ftsimprt <foreign file name> [FTS file name]

Example: ftsimprt stbuffer.byt stbuffer.cfa

If an FTS file name is not given, FTSIMPRT will use the foreign file name along with the default
extension.  For example, typing ftsimprt stbuffer.byt will convert stbuffer.byt to stbuffer.cfa.
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Importing Timestamps
Serialtest for DOS uses a timebase of Pacific Standard Time during non daylight savings time hours and
Pacific Daylight Time during daylight savings time hours.  FTS always uses Greenwich Mean Time
(also known as Universal Time Coordinates.)

When importing a Serialtest for DOS file, FTS must determine if the file was recorded during daylight
savings time or not before converting the timestamps.  Because the rules for determining this can
change, it is possible for FTS to convert the timestamps incorrectly, resulting in timestamps that are off
by one hour.

Spy Trial
The primary purpose of the trial version is to allow you to see if Spy is compatible with the hardware
you want to spy on.  Several features have been disabled in this version.

• The number of events captured is limited to 2000.
• Transmit capabilities are disabled.
• Saving data to disk is disabled.

The reminder message can be hidden behind other windows for 30 minutes.  If Spy is open for more
than 30 minutes, the message will come to the top of all other windows and cannot be hidden until Spy
is closed.

Handy Character Tables

ASCII Codes

EBCDIC Codes
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Baudot Codes

Communication Control Characters
Listed below in alphabetical order are the expanded text meanings for common ANSI communication
control characters, and FTS’s two-character abbreviation for each one.  Some abbreviations have
forward slash characters between the two letters.  This is to differentiate the abbreviations for a control
character from a hex number.  For example, the abbreviation for Form Feed is listed as F/F, to
differentiate it from the hex number FF.

Abbreviation Control Text
Character

AK ACK Acknowledge
BL BEL Bell
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BS BS Backspace
CN CAN Cancel
CR CR Carriage Return
D/1-4 DC1-4 Device Control 1-4
D/E DEL Delete
DL DLE Data Link Escape
EM EM End of Medium
EQ ENQ Enquiry
ET EOT End of Transmission
E/C ESC Escape
E/B ETB End of Transmission Block
EX ETX End of Text
F/F FF Form Feed
FS FS File Separator
GS GS Group Separator
HT HT Horizontal Tabulation
LF LF Line Feed
NK NAK Negative Acknowledge
NU NUL Null
RS RS Record Separator
SI SI Shift In
SO SO Shift Out
SH SOH Start of Heading
SX STX Start of Text
SB SUB Substitute
SY SYN Synchronous Idle
US US Unit Separator
VT VT Vertical Tabulation

Keyboard Shortcuts
This is a comprehensive list of the shortcuts in all products.

Breakout Box Ctrl + Shift + B
Cascade Windows Ctrl + W
Choose CRC Method F7
Clear Shift + F10
Close Window Ctrl + Q
Control Window Ctrl + Shift + C
Copy Ctrl + C
Cut Ctrl + X
Factory Defaults F10 (on Set I/O Configuration window)
Find Ctrl + F
Frame Decode Ctrl + Shift + D
Frame Summary Ctrl + Shift + M
Freeze F6
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Go To Ctrl + G
Help F1
Live Events Ctr l+ Shift + L
Open File/Config Ctrl + O
Options Alt + Enter
Paste Ctrl + V
Pause/Resume F10 (on Control, Live Events, Review Events, and Transmit windows)
Print Ctrl + P
Repeat Last Find F3
Reset F10 (on Breakout Box and Statistics windows)
Review Events Ctrl + Shift + R
Save Ctrl + S
Set I/O Configuration Ctrl + Shift + I
Signals Display Ctrl + Shift + N
Start Capture to Buffer F5
Start Capture to Disk Shift + F5
Statistics Ctrl + Shift + S
Transmit Ctrl + Shift + T
Transmit/Send F2
Undo Ctrl + Z

Glossary

DTE Device
DTE stands for Data Terminal Equipment.  A DTE device is any device that transmits data on pin 2 and
receives data on pin 3 using a standard DB25 pin connector.  An example of a DTE device is a personal
computer.

DCE Device
DCE stands for Data Communications Equipment.  A DCE device is any device that transmits data on
pin 3 and receives data on pin 2 using a standard DB25 pin connector.  An example of a DCE device is a
modem.

DTR - Data Terminal Ready
Control signal most commonly used by the DTE device to signal that it is on and ready.  On RS-232
circuits, DTR is usually assigned to pin 20.

RTS - Request to Send
Control signal most commonly used by the DTE device to indicate that it has data to send.  On RS-232
circuits, RTS is usually assigned to pin 4.  RTS is often used in conjunction with CTS for hardware flow
control.
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CTS - Clear to Send
Control signal most commonly used by the DCE device to indicate that it is ready to accept data.  On
RS-232 circuits, CTS is usually assigned to pin 5.  CTS is often used in conjunction with RTS for
hardware flow control.

DSR - Data Set Ready
Control signal most commonly used by the DCE device to indicate that it is on and ready.  On RS-232
circuits, DSR is usually assigned to pin 6.

CD - Carrier Detect
Control signal most commonly used by the DCE device to indicate that it has carrier.  On RS-232
circuits, CD is usually assigned to pin 8.  CD is sometimes called DCD, which stands for Data Carrier
Detect.

RI - Ring Indicator
Control signal most commonly used by the DCE device to indicate a ringing condition on a phone line.
On RS-232 circuits, RI is usually assigned to pin 22.  RI is sometimes called CI, which stands for Call
Indicator.

RS-232
RS-232 is shorthand for Recommended Standard #232.  This is a widely used standard for serial
communications defining the physical characteristics of the serial interface and cables.

Event
An event is anything that happens on the circuit or which affects data capture.  Data bytes, control signal
changes, and long and short breaks are all events, as are Set I/O Configuration changes and Data
Capture Paused and Resumed.  See Viewing Events for a list of all the special events in addition to data
bytes shown in Serialtest.

UART
Universal Asynchronous Receiver Transmitter.  This is the chip that controls the serial port.

Buffer Wrapping
When the capture buffer becomes full, the oldest events captured are pushed out of the buffer to make
room for new events.  This is called buffer wrapping, and events are referred to as having been
"wrapped" out of the buffer.  Any events wrapped out of the buffer are lost and cannot be recovered
unless you have opened a capture file and are saving events to disk.
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Snapshot
If you opened the Signal Display while capturing data, a snapshot consists of the events in the buffer at
the time the Signal Display was opened.  If you are viewing a capture file and are not actively capturing
data, then a snapshot consists of all the events in the capture file.

Frame Recognizer
The frame recognizer is the portion of the software that "recognizes" when a frame begins and when it
ends.  The frame recognizer inserts special markers in the capture file whenever it sees a Start of Frame
or End of Frame byte sequence, and these markers allow the protocol decodes to correctly identify the
frames.  Data is run through the frame recognizer at the time it is captured and only if a protocol that
frames data has been selected.  Data cannot be run through the frame recognizer after it has been
captured, therefore it is important to select the protocol before capturing data if you want it to be
decoded correctly.

MIL-STD-188C
A military data communications standard very similar to RS-232, except that the sense of the trnasmit
data and receive data lines is inverted.

Overrun Error
An overrun error means that an incoming byte has been lost.  This occurs when the software is not able
to keep up with the speed of incoming data.  Overrun errors occur when the processing load is too great
for the processing power of the PC.  If you are seeing overrun errors, the solution is to run on a faster
PC, slow down the baud rate, or both.

Underrun Error
An underrun error means that the software was not able to keep the output buffer full, resulting in an
unwanted gap between bytes sent.  Underrun errors occur when the processing load is too great for the
processing power of the PC.  If you are seeing underrun errors, the solution is to run on a faster PC, slow
down the baud rate, or both.
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